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Atalhos

Ao longo deste pequeno manual, em todos os atalhos referidos, é indicada, em primeiro lugar, 
a tecla para Macintosh e depois a tecla para Windows.
Como regra geral, pode dizer-se que tudo o que em Mac se faz com a tecla do comando, ou 
maçã (z ), se faz da mesma forma em Windows, utilizando a tecla Control [Ctrl]; e os menus 
contextuais a que temos acesso através do botão direito do rato, no sistema Windows, estão 
também disponíveis em Macintosh pressionando a tecla [Ctrl] e um clique no (único) botão do 
rato.

Língua: Inglês/Português

Uma vez que existem utilizadores da versão original (americana) e da versão traduzida 
(brasileira), optei por referir sempre em primeiro lugar os termos do programa em inglês 
(apresentados em itálico) e a seguir o correspondente português, separados por uma barra. 
Exemplo: ferramenta rectangular marquee / marca rectangular. 
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Atalhos

Ao longo deste pequeno manual, em todos os atalhos referidos, é indicada, em primeiro lugar, 
a tecla para Macintosh e depois a tecla para Windows.
Como regra geral, pode dizer-se que tudo o que em Mac se faz com a tecla do comando, ou 
maçã (z ), se faz da mesma forma em Windows, utilizando a tecla Control [Ctrl]; e os menus 
contextuais a que temos acesso através do botão direito do rato, no sistema Windows, estão 
também disponíveis em Macintosh pressionando a tecla [Ctrl] e um clique no (único) botão do 
rato.

Língua: Inglês/Português

Uma vez que existem utilizadores da versão original (americana) e da versão traduzida (bra-
sileira), optámos por referir sempre em primeiro lugar os termos do programa em inglês 
(apresentados em itálico) e a seguir o correspondente português, separados por uma barra. 
Exemplo: ferramenta rectangular marquee / letreiro rectangular. 
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A Paleta de Ferramentas (resumo)

1  Rectangular Marquee M
 / Letreiro rectangular
 Cria selecções rectangulares
2  Move / Mover V

 Move uma camada, selecção ou guia
3  Lasso  / Laço L

 Cria selecções de desenho livre
4  Magic Wand  / Varinha Mágica W

 Selecciona pixels de cor semelhante
5  Crop  / Corte Demarcado C

 Corta a área de trabalho
6  Slice  / Fatia K

 “Parte” imagens para a Web
7  Patch  / Correção J

 “Remenda” partes da imagem
8  Brush  / Pincel B

 Aplica pinceladas de cor
9  Clone Stamp  / Carimbo S

 Copia imagens ou partes de imagens
10  History Brush  / Pincel do Histórico Y 

 Restaura pixels de um estado anterior
11  Eraser  / Borracha E

 Apaga pixels
12  Gradient  / Degradê G 

 Cria gradações de cor
13  Blur  / Desfoque B

 Desfoca as áreas onde é usada
14  Dodge  / Subexposição O 

 Aclara os pixels da imagem
15  Direct Selection  / Seleção Directa A

 Selecciona segmentos e pontos de paths
16  Type  / Texto T 

 Cria texto editável numa camada própria
17  Pen  / Caneta P

 Desenha paths curvos ou rectos
18  Custom Shape Tool  / Forma personalizada U 

 Desenha formas vectoriais
19  Notes  / Observações N

 Cria anotações não imprimíveis
20  Eyedropper  / Conta-gotas I

 Retira uma amostra de cor da imagem
21  Hand  / Mão H

 Move a imagem na janela
22  Zoom  / Lupa Z 

 Aumenta/reduz a visualização
23  Cor Foreground

  / cor do primeiro plano
24  Switch  / Troca X 

  Troca a cor foreground com a background 
e vice-versa

25  Cores padrão Preto/Branco D 

26  Cor Background
  / cor do plano de fundo

27  Modo Standard  / Padrão Q 

28  Modo Quick Mask Q
  / Máscara Rápida
29  Écran no modo Standard F 
  / Modo Padrão de Tela
30  Écran total com barra de menu F  
  / Modo Tecla Cheia com Barra de Menus
31  Écran total F  
  / Modo Tecla Cheia
32  Passagem ao Image Ready
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Atalhos para usar com as Ferramentas

•   [Ctrl] + clique para visualizar um menu relativo à ferramenta em uso (no Mac) ou clique 
sobre o botão direito do rato (no Windows).

•   Pressionar [Caps Lock] para usar o cursor no modo preciso (em forma de cruz) para as 
ferramentas de pintura.

•   Pressione a barra de espaços para ter acesso temporário à ferramenta de deslocação ( ).

•   Pressione [Ctrl] (no Windows) ou z (no Mac) para ter acesso temporário à ferramenta de 
mover ( ). 

•   Pressione [Return] ou [Enter] para aplicar uma operação de uma ferramenta magnética, 
ou pressione [Esc] ou z + [ . ]  para cancelar a operação.

•   Pressionar [Ctrl] + barra de espaços (no Windows) ou z + barra de espaços (no Mac) para 
ter acesso temporário à lupa ( ). Se pretender ter acesso à lupa para diminuir ( ), deve 
pressionar também a tecla [Alt]  ( )

•   Para esconder temporariamente/mostrar de novo todas as paletas activas, menos a pale-
ta de ferramentas, premir as teclas + [TAB].

•   Para esconder temporariamente e para mostrar de novo todas as paletas activas, premir 
a tecla [TAB]

•   Pressionar  [Shift] para restringir o arrastamento ou o desenho de linhas rectas a múl-
tiplos de 45º.

A barra de opções 

A barra de opções pode situar-se no topo ou na base do écran, e exibe as opções da fer-
ramenta activa; o seu conteúdo é dinâmico, ou seja, vai sendo modificado à medida que 
diferentes ferramentas são seleccionadas. Algumas configurações na barra de opções são 
comuns a várias ferramentas (como modos de mistura de cores e opacidade) e outras são 
específicas de uma só ferramenta.

A barra de opções inclui um compartimento, à direita, apropriado para o armazenamento de 
paletas, oferecendo assim um acesso rápido a qualquer paleta. Nota: este compartimento só 
fica disponível quando for utilizada uma resolução de monitor superior a 800 × 600 pixels 
(sendo aconselhada 1024 × 768)

 Para devolver a uma ferramenta os valores-padrão (aqueles que vêm por defeito, com o pro-
grama), faça clique sobre o ícone da ferramenta em uso, na barra de opções à esquerda, e 
abra o menu de opções (com a seta no canto superior direito): escolha Reset Tool / Restaurar  
Ferramenta.

Se pretender colocar todas as ferra-
mentas com os valores-padrão, pro-
ceda do mesmo modo mas escolha 

Reset All Tools / Restaurar  Todas as Ferramentas.

Com um clique sobre o ícone da ferramenta em uso, na barra 
de opções, tem ainda acesso às predefinições da ferramenta 
em uso.
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1  A Ferramenta Marquee / Letreiro (atalho: M)

As Ferramentas Marquee / Letreiro ( ) / ( ) servem para 
criar selecções rectangulares ou elípticas, iniciando a selec-
ção sempre a partir do canto. Se premir continuadamente 
o rato sobre a ferramenta, pode escolher entre as duas 
(rectangular e elíptica) e ainda seleccionar uma única linha 
(horizontal ou vertical) com um pixel de largura.

Para fazer uma selecção: arraste com uma das marcas sobre a área que pretende selec-
cionar. Para que a largura e altura sejam iguais (fazendo quadrados ou círculos) prima a tecla 
[Shift] ao mesmo tempo que arrasta. Para desenhar a selecção a partir do centro, prima a 
tecla [Alt] ao arrastar. Use a Barra de Espaços para mover a selecção sem a desactivar.

Para modificar uma área seleccionada: vá ao menu Select > Transform Selection / 
Selecionar > Transformar Seleção para fazer surgir oito pegas que podem ser manipuladas. 
Para manter as proporções, prima a tecla [Shift] ao arrastar uma das pegas de canto; para 
distorcer, prima a tecla z / [Ctrl] ao arrastar uma das pegas de canto. Prima [Enter] ou faça 
duplo-clique dentro da área da selecção para aplicar a transformação. Prima [Esc] para can-
celar a transformação.

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Quatro ícones para, respectivamente: definir uma selecção simples (anulando qualquer 
outra que estivesse activa), adicionar selecção, subtrair selecção ou reter apenas a área de 
intersecção entre a nova selecção e outra já existente. Pode obter-se os mesmos resultados, 
premindo a tecla [Shift] – para adicionar; a tecla [Alt] – para subtrair; ou as teclas [Shift] + [Alt], 
em simultâneo, para intersectar.

3. Feather / Difusão: valor para esbater os contornos da área seleccionada: nos limites da 
selecção, o conteúdo vai ficando esbatido, até desaparecer. Este valor tem de ser dado sem-
pre antes de efectuar a selecção. Para adicionar feather / difusão a uma seleccção já existente, 
pode ir ao menu Select > Feather / Seleção > Difusão.

4. Anti-aliased / Suav. de Serr. Atenua o efeito de “escada” nos contornos de uma selecção 
em linhas não rectas (horizontais ou verticais). Só está disponível para a ferramenta elíptica 
e deve estar sempre activa.

5. Style / Estilo. Pode ser:
Normal, para determinar as dimensões da selecção através do arrastamento do rato.
Constrained Aspect Ratio / Índice do Aspecto Ajustado, para estabelecer uma relação propor-
cional entre a largura e a altura.
Fixed Size / Tamanho Fixo, para estabelecer valores prefedinidos, em pixeis, para a largura e altura 
da selecção. Depois basta um clique para criar a selecção a partir do canto superior esquerdo.

Barra de Opções para a Ferramenta Marquee / Letreiro

1 2 3 4 5
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2  A Ferramenta Move / Mover (atalho: V)

A ferramenta Move / Mover ( ) permite mover uma selecção ou layer / camada. Se a paleta 
Info / Informações estiver visível, pode seguir exactamente o movimento. 
•  Se mover uma área seleccionada no Background / Imagem de Fundo ficará, no lugar da 

selecção movida, uma área igual preenchida com a cor Background / Cor do Plano de 
Fundo.  

•  Se premir a tecla [Alt] ao mesmo tempo que arrasta, fará uma cópia da selecção. Mas cui-
dado, porque esta é uma selecção flutuante, que ficará colada à camada activa quando 
desseleccionar!

ATALHO:  Para ter acesso temporário à ferramenta Move / Mover, quando outra ferramenta 
está activa, basta premir a tecla z / [Ctrl]. Ao soltar esta tecla, volta à ferramenta 
que estava activa anteriormente. 

Nota:  esta técnica não funciona com as ferramentas: Pen / Caneta ( ), Direct Selection Tool 
/ Ferramenta de Seleção Directa ( ), Path Selection Tool / Ferramenta de Selecção de 
Demarcadores ( ),  Hand Tool / Mão ( ), Zoom / Lupa ( ), ou ferramentas de mani-
pulação de pontos ( ), ( +), ( –).

Barra de Opções para a Ferramenta Move / Mover

1 3

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Auto Select Layer / Selecção Automática de Camada. Activa/desactiva a selecção 
automática de camada com um simples clique. Nota: esta opção não funciona em camadas 
com opacidade inferior a 50%.

3. Show Bounding Box / Mostrar Caixa Delimitadora. Activa/desactiva caixa limitadora 
da(s) área(s) que têm pixéis na camada activa. Arrastando as pegas, é possível transformar/
rodar/redimensionar.

4. Ícones de alinhamento. Só se encontram disponíveis quando existem duas ou mais 
camadas ligadas entre si (com o ícone da corrente ao lado da miniatura da camada, na paleta 
de camadas). Permite fazer alinhamentos entre as camadas ligadas, alinhando, respectiva-
mente: os topos, os centros verticais, as bases, os lados esquerdos, os centros horizontais e 
os lados direitos.

5. Ícones de distribuição. Só se encontram disponíveis quando existem três ou mais cama-
das ligadas entre si. Servem para distribuir as camadas, colocando-as a distâncias iguais. 
Cada distribuição, pode ter como ponto de referência, respectivamente: os topos, os centros 
verticais, as bases, os lados esquerdos, os centros horizontais ou os lados direitos.

2 4 5
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3  A Ferramenta Lasso / Laço (atalho: L)

As ferramentas Lasso / Laço ( ) e Polygonal Lasso / Laço 
Poligonal ( ) servem para criar áreas de selecção arrastando 
livremente o rato ou fixando pontos com linhas rectas entre 
si. Com a ferramenta Magnetic Lasso / Laço Magnético ( ) os 
limites da selecção fixam-se por “atracção” aos contrastes de cor. 

Basta fazer um clique no ponto onde pretende iniciar a selecção e depois arrastar o rato (sem 
premir) ao longo do contorno da área que pretende seleccionar.

A barra de opções do laço simples e do laço poligonal é em tudo semelhante à da ferramenta 
marquee / letreiro. A do laço magnético é que difere:

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Quatro ícones para, respectivamente: definir uma selecção simples (anulando qualquer 
outra que estivesse activa), adicionar selecção, subtrair selecção ou reter apenas a área de 
intersecção entre a nova selecção e outra já existente. Pode obter-se os mesmos resultados, 
premindo a tecla [Shift] – para adicionar; a tecla [Alt] – para subtrair; ou as teclas [Shift] + [Alt], 
em simultâneo, para intersectar.

3. Feather / Difusão: valor para esbater os contornos da área seleccionada: nos limites da 
selecção, o conteúdo vai ficando esbatido, até desaparecer. Este valor tem de ser dado sem-
pre antes de efectuar a selecção. Para adicionar feather a uma seleccção já existente, pode ir 
ao menu Select > Feather / Seleção > Difusão.

4. Anti-aliased / Suav. de Serr. Atenua o efeito de “escada” nos contornos de uma selecção 
em linhas não rectas (horizontais ou verticais). 

5. Width / Largura do laço: área em torno do ponto do cursor onde o cursor vai “reconhe-
cer” o contraste entre pixéis.

6. Edge Contrast / Contraste. Sensibilidade do laço aos contornos de cor (1% a 100 %)

7. Frequency / Frequência. Frequência de pontos inseridos pelo programa, automatica-
mente.

8. Pen Pressure / Pressão da Caneta. Activa/desactiva a sensibilidade à pressão da 
caneta, para mesas digitalizadoras.

Numa imagem com grandes contrastes entre cores, pode usar valores mais elevados nos cam-
pos Lasso Width / Largura do Laço e Edge Contrast / Contraste, e traçar a área grosseiramente 
porque o “magnetismo” adere automaticamente às diferenças de cor. Para imagens com cores 
mais suaves, é aconselhável usar valores mais baixos e traçar a área com mais precisão.

Barra de opções para a ferramenta Magnetic Lasso / Laço Magnético 

1 2 3 4 5 6 7 8
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4  A Ferramenta Magic Wand / Varinha Mágica (atalho: W)

A Magic Wand / Varinha Mágica ( ) permite seleccionar uma área (ou várias áreas) de cor 
semelhante com um simples clique. Essa(s) área(s) pode ser mais ou menos abrangente(s), 
dependendo do valor Tolerance / Tolerância (em pixéis) fixado na barra de opções: um valor 
baixo selecciona cores muito semelhantes ao pixel sobre o qual se fez clique, um valor mais 
elevado abarca uma área de cores mais vasta (= mais tolerância).

Barra de opções para a ferramenta Magic Wand / Varinha Mágica

1 2 3 4 5 6

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Quatro ícones para, respectivamente: definir uma selecção simples (anulando qualquer 
outra que estivesse activa), adicionar selecção, subtrair selecção ou reter apenas a área de 
intersecção entre a nova selecção e outra já existente. Pode obter-se os mesmos resultados, 
premindo a tecla [Shift] – para adicionar; a tecla [Alt] – para subtrair; ou as teclas [Shift] + [Alt], 
em simultâneo, para intersectar.

3. Tolerance / Tolerância. Valor em pixéis que define mais ou menos tolerância em relação 
ao pixel sobre o qual se faz clique. Valor mais elevado (mais tolerância) = maior área selec-
cionada.

4. Anti-aliased / Suavização de Serrilhado. Atenua o efeito de “escada” nos contornos da 
selecção. Esta opção deve estar sempre activa.

5. Contiguos / Adjacente. Activa/desactiva a opção de seleccionar apenas tons contíguos 
(continuados, sem separações entre si).

6. Use All Layers / Utilizar Todas as Camadas. Activa/desactiva a possibilidade de “ler” 
cores em todas as camadas visíveis, e não apenas na camada activa.
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5  A Ferramenta Crop / Corte Demarcado (atalho: C)

A Ferramenta Crop / Corte Demarcado ( ) corta/reenquadra a imagem. Pode definir uma 
área para corte pelo simples arrastamento da ferramenta, ou pode fornecer valores fixos para 
largura, altura e resolução da área a cortar, através da barra de opções.

A Barra de Opções da Ferramenta Crop / Corte Demarcado

Para esta ferramenta, a barra de opções apresenta dois aspectos diferentes: um quando a 
ferramenta está seleccionada mas não foi ainda definida qualquer área para corte, e outro 
depois de definir essa área.

Este é o aspecto da barra quando activamos a ferramenta:

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Width / Largura. O valor para largura é dado na unidade de medida em uso; no entanto, 
pode acrescentar uma abreviatura para usar outra unidade de medida (ex.: px para pixéis, 
cm para centímetros, etc.)

3. Height / Altura. Também aqui pode usar uma abreviatura para uma unidade de medida 
diferente da que está em uso.

4. Resolution / Resolução. No menu à frente, pode escolher se este valor é em pixeis por 
polegada (pixels/inch) ou em pixéis por cm (pixels/cm).

5. Front Image / Imagem Frontal. Clique para colocar, automaticamente, os valores de 
largura, altura e resolução da imagem activa nos campos respectivos. Depois pode abrir outra 
imagem e cortá-la com o mesmo tamanho, arrastando com a ferramenta.

6. Clear / Apagar. Clique para limpar os campos numéricos da barra de opções.

Barra de opções para a ferramenta Crop / Corte Demarcado

1 3 4 52 6

Barra de opções para a ferramenta Crop / Corte Demarcado quando já existe uma área definida

3 4 5 61

1. Cropped Area: Delete, Hide / Área Cortada: Excluir, Ocultar. Antes de cortar a área, 
se a sua imagem contiver camadas, pode escolher cortar essa(s) camada(s) com a opção Delete 
/ Apagar ou simplesmente escondê-las, activando Hide / Esconder. Com esta segunda opção, 
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pode, depois, arrastar áreas da(s) camada(s) que tenha(m) ficado fora da imagem, mas que não 
foram cortadas. Esta opção não está disponível quando a imagem não tem camadas.

2. Shield / Proteger. Activa/desactiva a opção de cobrir a área a cortar por uma cor (esco-
lhida no quadrado seguinte) que ajuda o operador a decidir qual o melhor enquadramento.

3. Color / Cor. Clique para escolher a cor que cobre a área a cortar.

4. Opacity / Opacidade. Opacidade da cor escolhida no quadrado anterior.

5. Perspective / Perspectiva. Opção que permite corrigir a perspectiva de certas imagens, 
como a distorção em edifícios; com esta opção activa, pode mover as pegas para corrigir a 
perspectiva.

Depois de preenchidos correctamente todos os campos da barra de opções, e depois de 
arrastar/ajustar a área a cortar, pode premir a tecla [Enter] ou fazer duplo-clique dentro da 
área definida para efectivamente cortar.

6  A Ferramenta Slice / Fatia (atalho: K)

A Ferramenta Slice / Fatia ( ) serve para dividir em diferentes áreas funcionais uma imagem 
destinada à Web. Cada fatia é salva como um ficheiro independente contendo os seus pró-
prios parâmetros, paleta de cores, links, efeitos rollover e efeitos de animação.

Se o operador não definiu qualquer fatia, o programa considera toda a imagem como uma 
única fatia. Ao criar uma (ou mais) fatia(s), o programa automaticamente subdivide a área 
restante em fatias automáticas.

Barra de opções para a ferramenta Slice / Fatia

1 2 3 4 5

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Style / Estilo. Pode ser: 
Normal, para determinar as dimensões da fatia através do arrastamento do rato.
Constrained Aspect Ratio / Índice do aspecto ajustado, para estabelecer uma relação propor-
cional entre a largura e a altura.
Fixed Size / Tamanho Fixo, para estabelecer valores prefedinidos, em pixéis, para a largura e 
altura da fatia.

3. Width / Largura. Valor fixo para a largura da fatia.

4. Height / Altura. Valor fixo para a altura da fatia.

5. Slices from Guides / Fatias a partir das guias. Clique para criar fatias automaticamen-
te a partir das guias colocadas.
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A Ferramenta Slice Select Tool / Selecção de Fatias

A Ferramenta Slice Select Tool / Selecção de Fatias ( ), situa-se “por baixo” da ferramenta 
Slice / Fatia e permite seleccionar as fatias existentes.

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Quatro ícones para re-ordenar as fatias. São eles, respectivamente: passar para a 
frente de tudo, passar uma posição para a frente, passar uma posição para trás, passar para 
trás de tudo.

3. Slice Options... / Opções da Fatia... Abre uma janela com opções para a fatia activa.

4. Promote to User Slices / Forçar para Fatia do Usuário. Clique para transformar fatias 
automáticas em fatias do utilizador.

5. Divide Slice... / Dividir Fatia... Clique para dividir a fatia seleccionada.

6. Hide Auto Slices / Ocultar Fatias Automaticamente. Clique para esconder todas as 
fatias automáticas.

Barra de opções para a ferramenta Slice Select Tool / Seleção de Fatias

1 2 4 5 63

7  A Ferramenta Patch / Correção (atalho: J)

A Ferramenta Patch / Correção ( ) funciona entre uma área inicial e uma área destinatária, 
combinando a luz, textura e sombra da primeira para a segunda. Depois de activar esta ferra-
menta, deve seleccionar com ela uma área, que pode ser a origem ou o destino (dependendo 
do que decidir através da barra de opções); pode, em alternativa, usar um padrão.

À selecção feita com esta ferramenta pode ser atribuído um valor de feather / difusão, através 
do menu Select > Feather / Seleção > Difusão.

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

Barra de opções para a ferramenta Patch / Correcção

1 4 532 6
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2. Quatro ícones para, respectivamente: definir uma selecção simples (anulando qualquer 
outra que estivesse activa), adicionar selecção, subtrair selecção ou reter apenas a área de 
intersecção entre a nova selecção e outra já existente. Pode obter-se os mesmos resultados, 
premindo a tecla [Shift] – para adicionar; a tecla [Alt] – para subtrair; ou as teclas [Shift] + [Alt], 
em simultâneo, para intersectar.

3. Patch: Source, Destination / Corrigir: Origem, Destino. Através de um destes botões 
pode decidir se a zona seleccionada vai ser a origem (source) ou o destino (destination) da 
transformação a aplicar. Depois arraste a selecção para a área que pretende remendar ou onde 
pretende ir burcar informação. A mesma selecção pode ser arrastada para outras áreas.

4. Transparent / Transparente. Clique para fazer com que o resultado do “remendo” seja 
uma área “transparente” através da qual pode ver os pixéis originais.

5. Use Pattern / Usar Padrão. Clique para usar um padrão na zona a remendar.

6. Lista de padrões disponíveis.

A Ferramenta Healing / Recuperando Ferramenta Pincel

A Ferramenta Healing / Recuperando Ferramenta Pincel ( ) situa-se no mesmo local que a 
ferramenta Patch  / Correcção e serve para reparar áreas da imagem com informação retirada 
de outra área. Funciona da seguinte forma: para colher a informação que pretende depois 
transpor, faça clique sobre a área com a “boa” informação premindo ao mesmo tempo a tecla 
[Alt]. Depois basta “pincelar” sobre a zona a corrigir.
A ferramenta vai buscar a cor à zona de amostragem mas faz uma interpolação com a textura 
e luminosidade da zona de destino, resultando numa mistura de ambas. Deve usar pequenas 
“pinceladas” e esperar um pouco após cada uma para ver se o resultado é satisfatório.

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Brushes / Pincéis disponíveis.

3. Mode / Modo. Lista de modos de mistura de cor, que determinam como a cor aplicada se 
mistura com a cor já existente. Se escolher Normal não existe qualquer mistura. Se escolher 
Replace, a nova cor substitui completamente a cor existente. Os outros modos de mistura de 
cor estão descritos em detalhe no final do capítulo sobre ferramentas.

4. Source: Sampled, Pattern / Origem: Amostra, Padrão. Com um clique num destes 
botões, define se o ponto de origem é uma zona de amostragem (Sampled) determinada pelo 
[Alt] + clique ou se é um padrão (Pattern) já existente. Neste caso, a lista de padrões, a seguir, 
fica disponível.

Barra de opções para a ferramenta Healing / Recuperando Ferramenta Pincel

1 62 3  4 75
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5. Lista de padrões.

6. Aligned / Alinhado. Funciona da seguinte forma:
•  Com a opção Aligned / Alinhado activa, copia a área de referência apenas uma vez mesmo 

que páre e recomece a “pintar” várias vezes, permitindo continuar a imagem interrompida 
no mesmo ponto em que parou.

•  Com esta opção desactivada, pode aplicar a informação copiada sempre a partir do ponto 
inicial, de cada vez que larga o rato e recomeça a “pintar”.

7. Use All Layers / Utilizar Todas as Camadas. Activa/desactiva a possibilidade de ir bus-
car informação a todas as camadas visíveis, e não apenas à camada activa.

A Ferramenta Color Replacement / Substituição de Cor

Esta Ferramenta Color Replacement / Substituição de Cor ( ) substitui determinadas cores 
na imagem, pela cor foreground / cor do primeiro plano. Nota: antes de usar a ferramenta, 
lembre-se de fazer um clique sobre o quadrado de cor foreground / cor do primeiro plano 
para ter acesso ao Color Picker / Seletor de Cores e escolher a cor de substituição. ou então, 
use a Ferramenta  Eyedropper / Conta-gotas, para ir buscar a cor pretendida. 

Barra de opções para a ferramenta Color Replacement / Substituição de Cor

1 62 3  754  

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Brushes / Pincéis disponíveis.

3. Mode / Modo. Lista de modos de mistura de cor, que determinam como a cor aplicada 
se mistura com a cor já existente. Os modos de mistura de cor estão descritos em detalhe 
na página 39. Para esta ferramenta, o modo Color / Cor é o mais usual, e aquele que está 
predefinido. 

4. Sampling / Amostras. A forma de definir o ponto de amostragem, pode ter uma das 
opções:
Contínuos / Contínuo: para ir sempre retirando uma amostragem da cor sobre a qual vai 
arrastando o cursor;
 Once / Uma Vez: para substituir a cor apenas nas áreas com cor igual àquela sobre a qual fez 
clique (até levantar o rato);
Background Swatch / Amostra Fundo: para substituir apenas áreas contendo a cor que estiver 
no quadrado da cor do plano de fundo (cor background).

5. Limits / Limites. Limites da cor de substituição. Escolha uma das seguintes opções:
Discontiguous / Não-adjacente: para substituir a cor de amostragem sempre que ela surja 
debaixo do cursor;
 Contiguous / Adjacente: para substituir as cores contíguas à cor debaixo do cursor;
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8  A Ferramenta Brush / Pincel (atalho: B)

A Ferramenta Brush / Pincel ( ) permite aplicar pinceladas de cor, usando a cor foreground 
/ cor do primeiro plano, com um traço cuja espessura, dureza e opacidade são determinadas 
através das opções escolhidas na barra respectiva:

Atalhos:  Se fizer um clique com uma ferramenta de pintura e premir a tecla [Shift] ao fazer o 
segundo clique, faz uma linha recta entre os dois pontos.

  Se fizer [Alt] quando uma ferramenta de pintura está activa, o cursor transforma-se 
num conta-gotas. Isso significa que tem acesso temporário à ferramenta conta-gotas.

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Brushes / Pincéis disponíveis.

3. Mode / Modo. Lista de modos de mistura de cor, que determinam como a cor aplicada 
se mistura com a cor já existente. No final deste capítulo sobre ferramentas encontra uma 
descrição de todos os modos de mistura de cor que podem ser usados com as ferramentas 
de pintura (pág. 39).

4. Opacity / Opacidade do traço.

5. Flow / Fluxo. Regula o fluxo de tinta, determinando a “rapidez” com que uma pincelada 
surge na imagem. É mais eficaz quando se usa uma mesa digitalizadora.

6. Airbrush / Aerógrafo. Activa/desactiva o modo aerógrafo, que simula o uso deste tipo 
de caneta de desenhador.

Barra de opções para a ferramenta Brush / Pincel

1 42 3  5 6

 Find Edges / Indicação de Arestas: para substituir áreas seguidas com a cor de amostragem, 
mantendo os contrastes.

6. Tolerance / Tolerância. Valor, em pixéis, para a tolerância de cor, entre 0 e 255. Um valor 
baixo substitui cores muito semelhantes àquela onde se faz clique; um valor elevado substitui 
uma gama de cores mais vasta

7. Anti-aliased / Suavização de Serrilhado. Atenua o efeito de “escada” nos contornos de 
uma selecção em linhas não rectas (horizontais ou verticais). 
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Barra de opções para a ferramenta Pencil / Lápis

9  A Ferramenta Stamp / Carimbo (atalho: S)

A Ferramenta Stamp / Carimbo ( ) toma como referência um ponto da imagem ([Alt] + clique 
em simultâneo), e depois basta arrastar o cursor para “pintar” com a imagem de origem.

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Brushes / Pincéis disponíveis.

3. Mode / Modo. Lista de modos de mistura de cor, que determinam como a cor aplicada 
se mistura com a cor já existente. No final deste capítulo sobre ferramentas encontra uma 
descrição de todos os modos de mistura de cor que podem ser usados com as ferramentas 
de pintura (pág. 39).

4. Opacity / Opacidade do traço.

5. Flow / Fluxo. Regula o fluxo de tinta, determinando a “rapidez” com que uma pincelada 
surge na imagem. É mais eficaz quando se usa uma mesa digitalizadora.

6. Airbrush / Aerógrafo. Activa/desactiva o modo aerógrafo, que simula o uso deste tipo 
de caneta de desenhador.

7. Aligned / Alinhado. Funciona da seguinte forma:
•  Com esta opção activa, copia a área de referência apenas uma vez mesmo que páre e 

recomece a “pintar” várias vezes, permitindo continuar a imagem interrompida no mesmo 
ponto em que parou.

Barra de opções para a ferramenta Stamp / Carimbo

1 42 3  5 6

A Ferramenta Pencil / Lápis

A Ferramenta Pencil / Lápis ( ) funciona de modo semelhante ao Brush / Pincel, mas usa 
apenas pontas (brushes) rijas. A Barra de Opções é também semelhante mas não apresenta 
o campo Flow / Fluxo nem a opção Airbrush / Aerógrafo. Tem uma opção adicional: Auto 
Erase / Borracha Automática; ao activar esta opção, significa que se passar por cima de uma 
linha que fez anteriormente com esta ferramenta, a cor dessa linha será substituída pela cor 
background / cor do plano de fundo.

7 8
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1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Brushes / Pincéis disponíveis.

3. Mode / Modo. Lista de modos de mistura de cor, que determinam como a cor aplicada 
se mistura com a cor já existente. No final deste capítulo sobre ferramentas encontra uma 
descrição de todos os modos de mistura de cor que podem ser usados com as ferramentas 
de pintura (pág. 39).

4. Opacity / Opacidade do traço.

5. Flow / Fluxo. Regula o fluxo de tinta, determinando a “rapidez” com que uma pincelada 
surge na imagem. É mais eficaz quando se usa uma mesa digitalizadora.

6. Airbrush / Aerógrafo. Activa/desactiva o modo aerógrafo, que simula o uso deste tipo 
de caneta de desenhador.

7. Lista de padrões disponíveis.

8. Aligned / Alinhado. Funciona da seguinte forma:
•  Com a opção Aligned / Alinhado activa, repete o padrão uniformemente, mesmo que páre 

e recomece a “pintar” várias vezes, permitindo continuar o padrão interrompido no mesmo 
ponto em que parou. Se o padrão for mais pequeno que a imagem em uso, repete-o em 
quadrados seguidos.

•  Com esta opção desactivada, pode aplicar o padrão escolhido sempre a partir do ponto 
inicial, de cada vez que larga o rato e recomeça a “pintar”.

9. Impressionist / Impressionista. Activa/desactiva o modo Impressionista, que reproduz 
o padrão escolhido de forma aleatória.

Barra de opções para a ferramenta Pattern Stamp / Carimbo com Padrão

1 42 3  5 6 7 8 9

A Ferramenta Pattern Stamp / Carimbo de Padrão

A Ferramenta Pattern Stamp / Carimbo de Padrão ( ) permite aplicar um padrão existente 
através de pinceladas. Tem algumas semelhanças com o “outro” carimbo, mas a informação 
aplicada é escolhida de uma lista de padrões disponíveis.

•  Com esta opção desactivada, pode aplicar a informação copiada sempre a partir do ponto 
inicial, de cada vez que larga o rato e recomeça a “pintar”.

8. Use All Layers / Utilizar Todas as Camadas. Activa/desactiva a possibilidade de ir bus-
car informação a todas as camadas visíveis, e não apenas à camada activa.
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10   A Ferramenta History Brush / Pincel do Histórico 
(atalho: Y)

A Ferramenta History Brush / Pincel do Histórico 
( ) permite repor, com pinceladas, áreas de 
um estado anterior da imagem ou de um snap-
shot / instantâneo. Para definir qual o estado ou 
o snapshot onde vai buscar informação, deve 
assinalá-lo na paleta History / Histórico (ver 
imagens)

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Brushes / Pincéis disponíveis.

3. Mode / Modo. Lista de modos de mistura de cor, que determinam como a cor aplicada 
se mistura com a cor já existente. No final deste capítulo sobre ferramentas encontra uma 
descrição de todos os modos de mistura de cor que podem ser usados com as ferramentas 
de pintura (pág. 39).

4. Opacity / Opacidade do traço.

5. Flow / Fluxo. Regula o fluxo de tinta, determinando a “rapidez” com que uma pincelada 
surge na imagem. É mais eficaz quando se usa uma mesa digitalizadora.

6. Airbrush / Aerógrafo. Activa/desactiva o modo aerógrafo, que simula o uso deste tipo 
de caneta de desenhador.

Barra de opções para a ferramenta History Brush / Pincel do Histórico

1 42 3  5 6
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1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Brushes / Pincéis disponíveis.

3. Mode / Modo. Lista de modos de mistura de cor, que determinam como a cor aplicada 
se mistura com a cor já existente. No final deste capítulo sobre ferramentas encontra uma 
descrição de todos os modos de mistura de cor que podem ser usados com as ferramentas 
de pintura (pág. 39).

4. Opacity / Opacidade do traço.

5. Style / Estilo. Lista de estilos de pintura disponíveis.

6. Area / Área. Área a ser preenchida pelo traço da ferramenta.

7. Tolerance / Tolerância. Limita as áreas onde pode “pintar”. Um valor baixo permite 
pintar quase sem limites; um valor elevado limita a ferramenta a ser usada em áreas cuja cor 
difere bastante da cor que existia no estado assinalado na paleta History / Histórico.

Barra de opções para a ferramenta Art History Brush / Pincel de Arte do Histórico

1 42 3  5 6 7

A Ferramenta Art History Brush / Pincel de Arte do Histórico

A Ferramenta Art History Brush / Pincel de Arte do Histórico ( ) situa-se no mesmo local que 
a ferramenta anterior, e funciona de forma semelhante, mas aplica a informação colhida de 
forma impressionista e aleatória, podendo escolher diferentes estilos na barra respectiva.
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11  A Ferramenta Eraser / Borracha (atalho: E)

A Ferramenta Eraser / Borracha ( ) retira pixéis da camada activa. Se estiver a trabalhar no 
Background (imagem de fundo), ou numa camada onde esteja activa a opção Lock Transparent 
Pixels (bloquear pixéis transparentes), os pixéis por onde passa a ferramenta são substituídos 
pela cor Background / cor do plano de fundo. 

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Brushes / Pincéis disponíveis.

3. Mode / Modo. Lista de modos de mistura de cor, que determinam como a cor aplicada 
se mistura com a cor já existente. No final deste capítulo sobre ferramentas encontra uma 
descrição de todos os modos de mistura de cor que podem ser usados com as ferramentas 
de pintura (pág. 39).

4. Opacity / Opacidade do traço.

5. Flow / Fluxo. Regula o fluxo de tinta, determinando a “rapidez” com que uma pincelada 
surge na imagem. É mais eficaz quando se usa uma mesa digitalizadora.

6. Airbrush / Aerógrafo. Activa/desactiva o modo aerógrafo, que simula o uso deste tipo 
de caneta de desenhador. 

7. Erase to History / Apagar para Histórico. Com esta opção activa, a borracha funciona 
de forma idêntica à ferramenta History Brush / Pincel do Histórico, ou seja, repõe um estado 
anterior ou um snapshot / instantâneo assinalado na paleta History / Histórico.

Barra de opções para a ferramenta Eraser / Borracha

1 42 3  5 6 7
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A Ferramenta Background Eraser / Borracha de Plano Fundo

A Ferramenta Background Eraser / Borracha de Plano Fundo ( ) retira uma amostra da cor 
no centro do brush / pincel e apaga essa cor ao arrastar, sempre que ela aparece dentro da 
área do traço.

A Barra de Opções da Ferramenta Background Eraser / Borracha de Plano Fundo

 

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. 
Na janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher 
Reset Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas 
para devolver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as 
alterações que tenham sido feitas nas últimas operações.

2. Brushes / Pincéis disponíveis.

3. Limits / Limites. Modo de apagar os contornos (ou limites). As opções são:
Discontiguous / Não Adjacente, para apagar todos os pixéis parecidos (determinado pela tole-
rance / tolerância), quer sejam ou não seguidos. Com esta opção deve escolher também Once 
/ Uma vez, do menu Sampling / Amostras.
Contiguous / Adjacente, para apagar apenas pixéis seguidos com a mesma cor, dentro da 
tolerância escolhida.
Find Edges / Indicação de Arestas, para apagar pixéis contínuos, mas mantendo o contorno 
dos objectos.

4. Tolerance / Tolerância.  Valor em pixéis que define mais ou menos tolerância em rela-
ção à cor no centro do traço.

5. Protect Foreground Color / Proteger a cor de fundo. Activa/desactiva a opção de 
proteger a cor que estiver no quadrado de cor foreground / cor do primeiro plano. Sempre 
que esta cor surge dentro da área do traço, ela será preservada.

6. Sampling / Amostras. Opções relativas à amostra:
Continuous / Contínuo, para apagar todos os pixéis sobre os quais arrastar o cursor.
Once / Uma Vez, para apagar os pixéis muito semelhantes ao primeiro pixel sobre o qual fez 
clique.
Background Swatch / Amostra Fundo, para apagar apenas os pixéis muito semelhantes à cor 
de fundo (dentro da tolerância escolhida).

1 42 3  5 6
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A Ferramenta Magic Eraser / Borracha Mágica

A Ferramenta Magic Eraser / Borracha Mágica ( ) apaga ao fazer um simples clique sobre uma 
área da imagem, apagando uma área maior ou menor, em função da tolerância escolhida.

A Barra de Opções da Ferramenta Magic Eraser / Borracha Mágica

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Tolerance / Tolerância. Valor em pixéis que define mais ou menos tolerância em relação 
ao pixel sobre o qual se faz clique. 

3. Anti-Aliased / Suaviz. de Serr. Atenua o efeito de “escada” nos contornos da área apa-
gada. Esta opção deve estar sempre activa.

4. Contiguos / Contíguo. Activa/desactiva a opção de apagar apenas cores seguidas.

5. Use All Layers / Utilizar Todas as Camadas. Activa/desactiva a possibilidade de apa-
gar áreas, na camada activa, com base em cores encontradas em todas as camadas visíveis, 
e não apenas na camada activa.

6. Opacity / Opacidade. Percentagem de opacidade. 100% apaga completamente; percen-
tagens inferiores apagam parcialmente.

1 42 3  5 6
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12   A Ferramenta Gradient / Degradê (atalho: G)

A Ferramenta Gradient / Degradê ( ) cria uma gradação entre duas ou mais cores. Estas 
cores podem ser escolhidas de uma lista já existente ou podem criar-se novas combinações. 
Para definir a área, arrasta-se de um ponto inicial até ao ponto para terminar a gradação. Esta 
terá aspectos diferentes, dependendo do tipo de degradê escolhido na Barra respectiva.

A Barra de Opções da Ferramenta Gradient / Degradê

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Lista de Gradients / Degradês disponíveis.

3. Tipos de Degradê.

4. Mode / Modo. Lista de modos de mistura de cor, que determinam como as cores do 
degradê escolhido se misturam com a cor já existente. No final do capítulo sobre ferramentas 
encontra uma descrição de todos os modos de mistura de cor (pág. 39).

5. Opacity / Opacidade do degradê.

6. Reverse / Contrário. Inverte a direcção do degradê.

7. Dither / Pontilhamento. Suaviza a transição entre as cores que compõem o degradê.

8. Transparency / Transparência. Permite que o degradé tenha zonas transparentes.

1 42 3  5 76 8

Nota:  Para editar e alterar um degra-
dê existente, deve fazer clique 
sobre o degradê escolhido, 
na Barra de Opções, para ter 
acesso à janela de edição de 
degradés.



23ADOBE PHOTOSHOP CS

Formadoras: ÂNGELA RODRIGUES e ISABEL PINTO

A Ferramenta Paint Bucket / Balde de Tinta 

A Ferramenta Paint Bucket / Balde de Tinta ( ) situa-se “atrás” da Ferramenta Gradient / 
Degradê, na barra de ferramentas. Ela enche com a cor Foreground / Cor do plano da frente 
ou com um padrão (escolhido na barra de opções) uma área de cor semelhante (que pode ser 
maior ou menor, dependendo da tolerância).

A Barra de Opções da Ferramenta Paint Bucket / Balde de Tinta 

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Fill / Preenchimento. Pode escolher preencher com Pattern / Padrão ou com a cor Fore-
ground / Cor do primeiro plano. 

3. Lista de padrões disponíveis.

4. Mode / Modo. Lista de modos de mistura de cor, que determinam como a cor aplicada se 
mistura com a cor já existente. No final do capítulo sobre ferramentas encontra uma descrição 
de todos os modos de mistura de cor (pág. 39).

5. Opacity / Opacidade. Percentagem de opacidade para a cor a aplicar.

6. Tolerance / Tolerância. Valor em pixéis que define mais ou menos tolerância para as 
variações de cor. Valor mais elevado (mais tolerância) = maior área preenchida com cor.

7. Anti-Aliased / Suav. de Serr.. Atenua o efeito de “escada” nos contornos da área preen-
chida com cor. Esta opção deve estar sempre activa.

8. Contiguos / Contíguo. Activa/desactiva a opção de encher apenas áreas de tons contí-
guos (sem separações entre si).

9. All Layers / Todas as Camadas. Activa/desactiva a possibilidade de “ler” cores em todas 
as camadas visíveis, e não apenas na camada activa. A área de cor a preencher, no entanto, 
é sempre apenas na camada activa.

1 42 3  5 76 8 9
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13   As Ferramentas Blur / Desfocar, Sharpen / Nitidez e 
Smudge / Borrar (atalho: R)

A Ferramenta Blur / Desfocar ( ) vai desfocando as áreas da ima-
gem por onde passa, enquanto a Ferramenta Sharpen / Nitidez ( ) 
faz o inverso, ou seja, vai aguçando ou focalizando as áreas per-
corridas. Funcionam de forma semelhante aos filtros com o mesmo 
nome, mas é como se estes fossem aplicados com um pincel. 

A Ferramenta Smudge / Borrar ( ) simula a acção de espalhar a cor da imagem com um dedo, 
como se a imagem fosse de tinta fresca e com um dedo sobre um ponto se espalhasse essa 
cor na direcção em que se arrasta o rato. 

A Barra de Opções é idêntica para as três ferramentas; apenas a da ferramenta Smudge / 
Borrar tem a opção Finger Painting / Pintura a dedo que não existe para as outras duas.

A Barra de Opções das Ferramentas Blur / Desfocar, Sharpen / Nitidez e Smudge / Borrar

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Lista de Brushes / Pincéis disponíveis.

3. Mode / Modo. Lista de modos de mistura de cor, que determinam como as novas pincela-
das se misturam com as cores já existentes. No final do capítulo sobre ferramentas encontra 
uma descrição de todos os modos de mistura de cor (pág. 39).

4. Strength / Resistência. Intensidade da pincelada aplicada.

5. Use All Layers / Utilizar Todas as Camadas. Permite usar cor(es) de todas as camadas 
visíveis 

6. Finger Painting / Pintar com o Dedo. (só para a ferramenta Smudge / Borrar) simula 
espalhar a cor com um dedo molhado em tinta fresca, na cor foreground / cor do primeiro 
plano. 

1 42 5 63
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14   As Ferramentas Dodge / Subexposição, 
Burn / Superexposição e Sponge / Esponja (atalho: O)

As Ferramentas Dodge / Subexposição ( ), Burn / Superexposição 
( ) e Sponge / Esponja ( ) simulam as técnicas fotográficas tra-
dicionais para alterar a exposição (as duas primeiras ferramentas) 
e a saturação (no caso da ferramenta Sponge / Esponja) de uma 
imagem.

A Barra de Opções para as Ferramentas Dodge / Subexposição e Burn / Superexposição (a barra é idêntica para as duas ferramentas):

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Lista de Brushes / Pincéis disponíveis.

3. Range / Escala. Aqui pode escolher afectar as Shadows / Sombras, Midtones / Tons 
Médios ou Hightlights / Realces.

4. Exposure / Exposição. Percentagem de exposição.

5. Airbrush / Aerógrafo. Activa/desativa o modo aerógrafo, que simula o uso das canetas 
de desenhador com o mesmo nome.

A Barra de Opções para a Ferramenta Sponge / Esponja

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Lista de Brushes / Pincéis disponíveis.

3. Mode / Modo. Aqui pode escolher Desaturate / Remover Saturação ou Saturate / Saturar.

4. Flow / Fluxo. Regulação do fluxo. Mais eficaz quando se usa uma mesa digitalizadora.

5. Airbrush / Aerógrafo. Activa/desativa o modo aerógrafo, que simula o uso destas cane-
tas de desenhador.

1 2 4 53

1 2 4 53
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15   As Ferramentas de Selecção de Paths / 
Demarcadores (atalho: A)

A Ferramenta de Selecção de Paths / Demarcadores ( ) serve para seleccionar um Path/
Demarcador. Se pretender seleccionar apenas um (ou alguns) ponto(s) de um path/demarca-
dor, deve usar a ferramenta de selecção directa ( ). Esta última ferramenta não tem opções 
na Barra respectiva.

A Barra de opções para a Ferramenta de Selecção de Paths / Demarcadores

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Show Bounding Box / Mostrar caixa delimitadora.

3. Estes quatro ícones regulam como os subpaths / subdemarcadores se “relacionam” entre 
si. Cada um destes permite, respectivamente: adicionar a outro subpath/subdemarcador; 
subtrair de outro subpath/subdemarcador; interceptar com outro subpath/subdemarcador; 
excluir áreas sobrepostas de subpaths/subdemarcadores.

4. Combine / Combinar. Combina vários subpaths/subdemarcadores transformando-os 
num só.

5. Estes ícones só se encontram disponíveis quando existem dois ou mais subpaths/subde-
marcadores seleccionados. Permite fazer alinhamentos entre eles, alinhando, respectivamen-
te: os topos, os centros verticais, as bases, os lados esquerdos, os centros horizontais e os 
lados direitos.

6. Estes ícones só se encontram disponíveis quando existem três ou mais subpaths/subde-
marcadores seleccionados. Servem para distribuí-los, colocando-os a distâncias iguais. Cada 
distribuição, pode ter como ponto de referência, respectivamente: os topos, os centros verti-
cais, as bases, os lados esquerdos, os centros horizontais ou os lados direitos.

7. Desativa o path / demarcador em uso.

1 2 4 63 5 7
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16   A Ferramenta Type / Texto (atalho: T)

Existem duas ferramentas que permitem criar texto editável em qualquer momento. Situam-
se no mesmo local da paleta de ferramentas. A primeira cria texto horizontal ( ) e a segunda 
cria texto vertical ( ), podendo alterar-se um para o outro, ou seja, pode criar inicialmente 
texto vertical e depois modificar para texto horizontal e vice-versa.

Nota: ao criar texto com a ferramenta Type / Texto, surge automaticamente uma nova cama-
da de texto na Paleta Layers / Camadas. Quando pretender reeditar o texto, basta fazer um 
duplo-clique sobre a miniatura desta camada.

A Barra de Opções da Ferramenta Type / Texto

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Clique para alternar entre texto horizontal e vertical.

3. Lista de fontes disponíveis

4. Estilo (normal, negro, itálico, etc.)

5. Corpo do texto (tamanho das letras)

6. Método de anti-aliasing / suavização do serrilhado das letras

7. Alinhamento do texto.

8. Cor do texto.

9. Aplicar uma distorção ao texto.

10. Mostra/esconde as Paletas Character / Caractere e Paragraph / Parágrafo.

Nota:  todas as opções disponíveis na Barra existem também nas Paletas Character / Caractere 
e Paragraph / Parágrafo, que têm ainda outras opções para formatação do texto.

1 2 4 73 5 106 8 9
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A Ferramenta Type Mask / Máscara de Texto

No mesmo local da paleta de ferramentas, existem duas ferramentas Type Mask / Máscara de 
Texto, que servem para criar uma selecção em forma de texto, com o tipo, tamanho e estilo 
de letra seleccionada na barra respectiva. Este texto pode ser horizontal ( ) ou vertical 
( ).

Esta ferramenta não cria nenhuma camada (ao contrário da anterior); antes cobre a imagem 
com uma cor (como o modo Quick Mask / Máscara Rápida) e à medida que se escreve, vão 
ficando áreas transparentes, em forma das letras digitadas. Quando mudar de ferramenta, 
a cor desaparece e as áreas transparentes surgem como áreas seleccionadas. A partir daqui, 
esta selecção funciona como qualquer selecção: pode transformar-se através do menu Select 
> Transform Selection / Seleção > Transformar Seleção; pode mover-se esta área através da 
ferramenta Move / Mover, etc.

Este texto não é editável.

A Barra de Opções é igual à barra de opções para a primeira ferramenta de texto.

17   As Ferramentas Pen / Caneta (atalho: P)

No mesmo local da paleta de ferramentas, existem várias ferramentas Pen / Caneta ( ), ( ), 
( +), ( –), ( ); todas permitem criar formas a que chamamos paths / demarcadores, e 
que podem depois ser manuseados através da paleta com o mesmo nome (Paleta Paths / 
Demarcadores).

Eles podem ter três funções distintas. Podem servir:
- como ferramenta de desenho (pintando depois o interior e/ou o contorno);
- como mais uma forma de selecção (têm depois de ser transformadas em selecção);
-  como máscara recortante para esconder parte(s) da imagem ao ser colocada num programa 

de paginação.

Um path / demarcador pode ser formado por linhas rectas ou curvas (chamadas curvas 
Bézier) das quais partem pegas. Tanto os pontos como as curvas podem ser manipulados 
através da ferramenta de selecção directa ( ). Para acrescentar ou retirar pontos, deve usar 
a caneta + ( +) ou a caneta – ( –), respectivamente. 
As duas primeiras canetas ( ) e ( ) servem para criar paths / demarcadores. A primeira 
fixando pontos com linhas entre si; a segunda fazendo desenhos livres.
Quando pretender transformar um ponto curvo (no meio de um arco) num ponto bicudo (entre 
duas rectas), ou o inverso, use a ferramenta Convert Point / Conversora de Pontos ( ).
Ao usar a caneta de desenho livre ( ), se assinalar a opção Magnetic / Magnética, pode arras-
tar o rato ao longo de uma forma de cores contrastantes, e as linhas do path / demarcador 
aderem automaticamente, reagindo à diferenças de cor; é semelhante ao laço magnético.

A Caneta pode também servir para criar uma nova camada de formas vectoriais, se activar, na 
Barra de Opções, o primeiro dos três ícones de formas ( ), antes de iniciar o “desenho”.
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A Barra de Opções das Ferramentas Pen / Caneta 

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Seleccionando um destes três ícones, decide o que vai ser o seu “desenho”: 
com o primeiro ícone cria uma nova camada de formas vectoriais;
com o segundo ícone cria um work path / demarcador de trabalho;
o terceiro ícone só está disponível para as formas vectoriais e cria uma nova área de cor na 
camada que estiver activa.

3. Deste conjunto de ícones pode seleccionar se vai usar a caneta simples, a caneta de dese-
nho livre, uma forma vectorial predefinida, ou uma forma personalizada. Neste caso, surge 
um menu onde pode abrir uma lista com as formas disponíveis. 

4. Opções específicas da forma seleccionada.

5. Auto Add/Delete / Adicionar/Remover Auto. Adicionar/retirar pontos automatica-
mente. Isto significa que se passar por cima da linha de um path / demarcador, a ferramenta 
transforma-se na caneta+, e se passar por cima de um ponto, surge a caneta –.

6. Estes quatro ícones regulam o que vai acontecer à nova forma, em caso de já existirem 
outros paths / demarcadores: adiciona a outro subpath / subdemarcador; subtrai de outro 
subpath/subdemarcador; intercepta com outro subpath/subdemarcador; exclui áreas sobre-
postas de subpaths / subdemarcadores.

1 2 63 4 5
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18   A Ferramenta Shapes / Formas Vectoriais (atalho: U)

A Ferramenta Shapes / Formas Vectoriais permite dese-
nhar formas vectoriais, podendo escolher formas geomé-
tricas predefinidas (rectângulo com ou sem cantos redon-
dos, elipse, polígono e linha) ou uma forma personalizada, 
podendo escolher desenhos de uma longa lista que surge 
na Barra de Opções respectiva.

Estas formas vectoriais são manipuladas da forma já explicada para os paths / demarcadores, 
ou seja, pode mover toda a forma com a ferramenta de selecção de paths / demarcadores ( ) 
ou pode manusear pontos e pegas através da ferramenta de selecção directa ( ).

Pode ainda acrescentar e retirar pontos com as canetas mais e menos, respectivamente, e 
também converter o tipo de pontos com a ferramenta Convert Point / Conversora de pontos 
( ).

À semelhança do que acontece com a ferramenta Pen / Caneta, a Barra de Opções apresenta 
um conjunto de três ícones onde pode escolher (respectivamente):
criar uma nova camada de formas vectoriais;
criar um work path / demarcador de trabalho;
ou criar uma nova área de cor na camada que estiver activa.

O conteúdo da Barra modifica-se em função de cada uma destas opções. A Barra de Opções é 
semelhante quando vai criar uma nova forma vectorial (1.º ícone) ou um work path / demar-
cador de trabalho (2.º ícone), embora esta última tenha menos opções:

A Barra de Opções para as Formas Vectoriais, quando vai criar uma nova forma vectorial:

A Barra de Opções para as Formas Vectoriais, quando vai traçar um work path / demarcador de trabalho:

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Nova camada de formas vectoriais ou novo work path / demarcador de trabalho (surge 
automaticamente na Paleta Paths / Demarcadores e é temporário, até que se crie outro).

3. Deste conjunto de ícones pode seleccionar se vai usar uma forma vectorial predefinida 
(rectângulo com ou sem cantos redondos, elipse, polígono e linha) ou uma forma personali-
zada. Neste caso, surge um menu onde pode abrir uma lista com as formas disponíveis. 

1 2 63 4 5 7 8 9
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4. Opções específicas da forma seleccionada.

5. Raio para os cantos redondos do rectângulo.

6. Estes quatro ícones regulam o que vai acontecer à nova forma, em caso de já existirem 
outros paths / demarcadores: adiciona a outro subpath / subdemarcador; subtrai de outro 
subpath / subdemarcador; intercepta com outro subpath / subdemarcador; exclui áreas sobre-
postas de subpaths / subdemarcadores.

7. Botão para preservar as propriedades da camada com formas vectoriais.

8. Atribuir um estilo à camada

9. Cor para a camada.

A Barra de Opções para as Formas Vectoriais, quando vai criar uma nova área de cor na camada activa:

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Nova área de cor.

3. Deste conjunto de ícones pode seleccionar se vai usar uma forma vectorial predefinida 
(rectângulo com ou sem cantos redondos, elipse, polígono e linha) ou uma forma personali-
zada. Neste caso, surge um menu onde pode abrir uma lista com as formas disponíveis. 

4. Opções específicas da forma seleccionada.

5. Raio para os cantos redondos do rectângulo.

6. Mode / Modo. Lista de modos de mistura de cor, que determina como a cor da nova área 
de cor se mistura com as cores já existentes. No final do capítulo sobre ferramentas encontra 
uma descrição de todos os modos de mistura de cor (pág. 39).

7. Opacity / Opacidade. Opacidade da cor.

8. Anti-Aliased / Suav. de Serr.. Atenua o efeito de “escada” nos contornos da área preen-
chida com cor. Esta opção deve estar sempre activa.

1 2 3 4 5 6 7 8
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19   As Ferramentas Notes / Notas e 
Audio Annotation / Anotações Sonoras (atalho: N)

As Ferramentas Notes / Notas ( ) e Audio Annotation / Anotações Sonoras ( ) permitem 
adicionar anotações tanto escritas (semelhantes a post-its), como sonoras, introduzindo som 
através de um gravador.
Nenhuma destas anotações é imprimível.

A Barra de Opções é semelhante para ambas as ferramentas; apenas a ferramenta de anota-
ções sonoras não apresenta campo para tipo e tamanho de letra.

A Barra de Opções para as Ferramentas Notes / Notas e Audio Annotation / Anotações Sonoras 

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Identificação de quem escreve a nota

3. Tipo de letra para o texto

4. Tamanho da letra para o texto

5. Cor para a barra no topo da nota

6. Clique para apagar todas as notas do documento.

1 2 3 4 5 6
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20   A Ferramenta Eyedropper / Conta-gotas (atalho: I)

A Ferramenta Eyedropper / Conta-gotas ( ) serve para ir buscar cor a qualquer ponto da 
imagem e colocar essa cor como cor foreground / cor do primeiro plano. Se premir a tecla [Alt] 
ao mesmo tempo que faz clique com esta ferramenta, essa cor passará para cor background 
/ cor do plano de fundo.

A Ferramenta Color Sampler / Classificador de Cores

A Ferramenta Color Sampler / Classificador de Cores ( ) permite fixar até quatro pontos 
de amostragem de cor em cada imagem. A informação da composição de cor destes pontos, 
numerados, aparece na paleta Info / Informações. Para retirar um destes pontos basta arras-
tá-lo para fora da imagem. Para retirar todos, faça clique sobre o botão [Clear All] / [Limpar 
todos], na Barra de Opções. Esta, é igual para as duas ferramentas.

A Barra de Opções para as Ferramentas Eyedropper / Conta-gotas e Color Sampler / Classificador de Cores

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Aqui pode escolher se a sua “amostra” vai ser de:
 - Point Sample / Amostra de ponto 
 - 3 by 3 average / média de 3 por 3 
 - 5 by 5 average / média de 5 por 5

3. Clear / Apagar. Apagar todos os pontos de amostragem. Só para a ferramenta Color 
Sampler / Classificador de Cores.

1 1 2  
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A Ferramenta Measure / Medir

A Ferramenta Measure / Medir ( ) efectua medições entre dois pontos (apenas uma medi-
ção de cada vez). O valor da medida aparece na Barra de Opções e também na Paleta Info / 
Informações.
Para medir, basta activar a ferramenta e arrastar com o rato entre os pontos pretendidos. 
Se premir a tecla [Shift] ao mesmo tempo que arrasta, o movimento do rato ficará restrito a 
ângulos de 45º, o que permite traçar linhas direitas.

A Barra de Opções da Ferramenta Measure / Medir

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Coordenada horizontal (X) da origem da medição.

3. Coordenada vertical (Y) da origem da medição.

4. Largura.

5. Altura.

6. Ângulo.

7. Distâncias de um máximo de duas medições.

8. Limpar as linhas de medição.

1 2 3 4 5 6 7 8
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21   A Ferramenta Hand / Mão (atalho: H)

A Ferramenta Hand / Mão ( ) serve para deslocar a imagem no ecrã, sempre que a visuali-
zamos grande demais para caber toda na área visível. 

Atalho: Sempre que estiver a usar outra ferramenta, pode ter acesso temporário à ferramenta 
da mão ao premir a Barra de Espaços (excepto quando está a usar a ferramenta de Texto).

A Barra de Opções da Ferramenta Hand / Mão

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Clique para ver a imagem a 100% de recolução.

3. Clique para que a imagem encha o ecrã.

4. Clique para ver a imagem no tamanho de impressão.

1 2 3 4
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22   A Ferramenta Zoom / Lupa (atalho: Z)

A Ferramenta Zoom / Lupa ( ) permite aumentar ou diminuir a visualização da imagem.

Atalhos: Para ter acesso temporário a esta ferramenta, para aumentar, basta premir em 
simultâneo as teclas z / [Ctrl] + Barra de Espaços.
Se pretender diminuir a visualização, então deve premir em simultâneo as teclas z / [Ctrl] + 
[Alt] + Barra de Espaços.
Para aumentar pode premir as teclas z / [Ctrl] + [+], e dar cliques com o rato; para diminuir, 
prima z / [Ctrl] + [–] e faça clique com o rato.
Para fazer com que a imagem preencha o ecrã: z / [Ctrl] + 0 (zero).

A Barra de Opções para a Ferramenta Zoom / Lupa

1. Ícone da ferramenta em uso. Clique para ter acesso às predefinições da ferramenta. Na 
janela que se abre, pode fazer clique sobre a seta do canto superior direito e escolher Reset 
Tool  / Restaurar  Ferramenta ou Reset All Tools  / Restaurar  Todas as Ferramentas para devol-
ver a esta ferramenta ou a todas as ferramentas os valores-padrão, “limpando” as alterações 
que tenham sido feitas nas últimas operações.

2. Clique num destes ícones para escolher aumentar ou diminuir

3. Resize Windows to Fit / Redimensionar para Ajustar Janelas. Força a janela ajustar-
se ao tamanho da imagem, à medida que esta é aumentada ou diminuída.

4. Ignore Paletes / Ignorar Paletas. Clique para que a imagem possa “crescer” para lá da 
área das paletas.

5. Actual Pixels / Tamanho Original. Clique para ver a imagem na resolução real.

6. Fit On Screen / Ajustar à Tela. Força a imagem a preencher a janela do programa.

7. Print Size / Tamanho de Impressão. Clique para ver a imagem no tamanho em que vai 
ser impressa.

1 2 3 4 5 6 7
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23   Cor Foreground / Cor do Primeiro Plano

Esta é a cor que as ferramentas de pintura utilizam. Se fizer clique sobre este quadrado, abre 
o Color Picker / Seletor de Cores, onde pode escolher outra cor. Neste painel as cores podem 
ser escolhidas sobre um espectro de cor ou com valores numéricos, que podem ser expressos 
nos modelos de cor: HSB, RGB, Lab ou CMYK.
Outra forma de escolher uma cor para este quadrado, é através da paleta Swatches / Amostras 
de cor ou usando a ferramenta Eyedropper / Conta-gotas.

24   Switch / Troca (atalho: X)

Com um clique sobre esta seta de duas pontas, troca a cor foreground / cor de primeiro plano 
com a cor background / cor de plano de fundo. Pode usar o atalho: letra X.

25   Cores-padrão: preto e branco (atalho: D)

Sempre que precisar de usar preto e branco, basta clicar sobre estes quadradinhos. Pode usar 
o atalho: letra D.

26   Cor Background / Cor do Plano de Fundo

Esta é a cor usada pela borracha, ou sempre que apaga uma área na imagem Background / 
imagem do plano de fundo. 
Se fizer clique sobre este quadrado, abre o Color Picker / Painel de Cores, onde pode escolher 
outra cor. Neste painel as cores podem ser escolhidas sobre um espectro de cor ou com valo-
res numéricos, que podem ser expressos nos modelos de cor: HSB, RGB, Lab ou CMYK.
Outra forma de escolher uma cor para este quadrado, é através da paleta Swatches / Amostras 
de cor ou usando a ferramenta Eyedropper / Conta-gotas, ao mesmo tempo que prime a tecla 
[Alt].

27   e 28   Modo Standard e Modo Quick Mask / Máscara 
Rápida (atalho: Q)

Sempre que tem uma selecção activa e pretende ver melhor ou retocar essa selecção, pode 
entrar no modo Quick Mask / Máscara Rápida (atalho Q); isto fará com que a sua selecção (ou 
a área não seleccionada) fique coberta com uma cor para rápida distinção entre as duas áreas. 
Esta cor, e a sua opacidade, pode ser mudada através das opções do Quick Mask / Máscara 
Rápida, onde se chega com um duplo-clique sobre o ícone Quick Mask / Máscara Rápida.

Estando no Modo Quick Mask / Máscara Rápida, pode usar as ferramentas de pintura para 
retocar a selecção, usando preto para adicionar cor ou branco para a retirar. Quando regres-
sar ao modo Standard (letra Q) a selecção estará modificada de acordo com os retoques feitos 
através da cor.
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29 , 30   e 31   Modos de Apresentação do Ecrã (atalho: F)

Digitando sucessivamente a letra F ou fazendo cliques em cada um destes três ícones, pode 
passar-se pelos três modos de apresentação do ecrã:
- Ecrã no modo Standard
- Ecrã total com barra de menus (em fundo cinzento)
- Ecrã total (visualiza apenas a imagem em fundo preto)

32   Jump to Image Ready / Saltar para o Image Ready 
(atalho: z/Ctrl + Shift + M)

Clique para passar ao Image Ready
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Os Modos de Mistura de Cores

Os modos de mistura de cores controlam como a 
cor da imagem é afectada por uma ferramenta de 
pintura ou de edição, e são uma opção disponível 
na Barra de Opções. Também através do menu Edit > Fill / Editar > 
Preencher, se podem misturar as cores. 
Os possíveis modos que surgem na Barra de Opções são:

Normal

A cor final é igual à cor aplicada. 
Este é o modo padrão. O modo Normal é chamado Threshold / 
Limite quando se trabalha em imagens em modo bipmap (preto e 
branco) ou em cor indexada (indexed color).

Dissolve / Dissolver

Pinta cada pixel para o transformar na cor resultante. Contudo, a 
cor resultante é uma substituição aleatória dos pixéis pela cor base 
ou pela cor de mistura, dependendo da opacidade na localização 
de cada pixel. Este modo funciona melhor quando aplicado com o 
pincel e com um brush / pincel grande.

Behind / Atrás

Pinta apenas a parte transparente de uma camada (Layer). Este modo trabalha apenas em 
camadas com Preserve Transparency / Preservar Transparência desligado e é semelhante a 
pintar na parte de trás de áreas transparentes numa folha de acetato. Só está disponível para 
as ferramentas de pintura e para o menu Edit > Fill / Editar > Preencher.

Clear / Apagar

Este modo só está disponível para uma imagem com camadas. Funciona com as Ferramentas 
de Pintura (pincel e lápis), com a Lata de Tinta e no menu Edit > Fill / Editar > Preencher. Ao 
usar este modo, as zonas afectadas ficarão transparentes (por isso não pode ser usado no 
Background / Imagem de fundo, que não suporta transparências).

Misturas neutras com branco

Neste grupo, todos têm o branco como cor neutral. 
Isto quer dizer que, sempre que a cor de mistura 
seja branco, o resultado será nulo  (nada se modi-
fica na imagem). Se criar uma nova camada através 
do menu Layer > New > Layer / Camada > Nova 
> Camada e escolher um modo de mistura de cor 

deste grupo, a própria janela de criação da camada contém a opção de encher com branco. 
Depois, pode pintar e obterá resultados diferentes, dependendo da cor usada e do modo de 
mistura activo.

Darken / Escurecer

Ao misturar duas cores, camadas ou padrões neste modo, os pixéis correspondentes são 
comparados e a cor resultante é composta pelos pixéis mais escuros de cada uma.

Misturas 
neutras 

com  
branco

Misturas 
neutras 
com  

preto

Misturas 
neutras 

com  
cinzento 
a 50 %
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Multiply / Multiplicação

Analisa a informação de cor em cada canal e multiplica a cor base pela cor de mistura. A cor 
resultante é sempre uma cor mais escura. Multiplicar qualquer cor com preto produz preto. 
Quando se pinta com outra cor que não o branco ou o preto, pinceladas sucessivas com uma 
Ferramenta de Pintura produzem cores progressivamente mais escuras. 

Color Burn / Superexposição de Cores 

O modo Color Burn escurece e contrasta tanto mais a cor resultante, quanto mais escura for 
a cor de mistura. 

Linear Burn / Superexposição Linear

Com este modo, a cor de base vai sendo mais escura à medida que a cor de mistura vai sendo 
mais e mais escura. Misturada com preto, produz preto. É semelhante ao modo anterior, mas 
parece utilizar mais os valores de luminosidade, enquanto o outro altera mais o contraste.

Misturas neutras com preto

Neste grupo, todos têm o preto como cor neutral. 
Assim, sempre que a cor de mistura seja, o preto o 
resultado será nulo  (nada se modifica na imagem). 
Se criar uma nova camada através do menu Layer > 
New > Layer / Camada > Nova > Camada e escolher 
um modo de mistura de cor deste grupo, a própria 

janela de criação da camada contém a opção de encher com preto. Depois, pode pintar e obterá 
resultados diferentes, dependendo da cor usada e do modo de mistura activo.

Lighten / Clarear

Ao misturar duas cores, camadas ou padrões neste modo, os pixéis correspondentes são com-
parados e a cor resultante é composta pelos pixéis mais claros de cada uma.

Screen / Divisão
A informação de cada canal é multiplicada pelo inverso das cores base e de mistura. A cor 
resultante é sempre uma cor mais clara. Este modo aplicado a preto deixa a cor inalterada; 
aplicado a branco produz branco. O efeito é semelhante a projectar múltiplos slides fotográ-
ficos sobrepostos.

Color Dodge / Subexposição de Cores

Este modo aclara a imagem original ou a cor base, alterando o contraste conforme a cor de 
mistura for mais e mais clara. Em mistura com preto, o resultado é nulo; ao misturar cores 
progressivamente mais claras a cor ou a imagem resultante é cada vez mais brilhante.

Linear Dodge / Subexposição Linear

Com este modo, a cor resultante é mais aclarada com cores de mistura mais claras. Funcio-
nando de forma semelhante ao modo anterior, parece alterar mais o contraste. 

Misturas neutras com cinzento a 50 %

Neste grupo de modos de mistura de cor, todos têm 
o cinzento a 50% como cor neutral. Isto quer dizer, 
que sempre que a cor de mistura seja cinzento a 
50 % o resultado será nulo (nada se modifica na ima-
gem). Se criar uma nova camada através do menu 
Layer > New > Layer / Camada > Nova > Camada 
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e escolher um modo de mistura de cor deste terceiro grupo, a própria janela de criação da 
camada contém a opção de encher com 50 % de cinzento. Depois, ao pintar ou misturar cores 
mais claras do que 50 % de cinzento o resultado será cores ou imagens mais claras ou mais 
brilhantes. Se pintar ou misturar cores mais escuras do que 50 % de cinzento o resultado será 
cores ou imagens mais escuras ou mais sombreadas. Claro que os resultados serão diferentes 
dependendo das imagens e dos modos de mistura usados.

Overlay / Sobrepor

Aplica o modo Multiply / Multiplicação ou Screen / Divisão, dependendo da cor base. Tramas 
ou cores sobrepõem os pixéis existentes, enquanto preservam os tons claros (Highlights / 
Realces) e as sombras (Shadows / Sombras) da cor base. A cor base não é substituída, mas 
misturada com a nova cor (cor de mistura) para reflectir a luminosidade ou sombra da cor 
original. Os tons e os detalhes da imagem original são de certo modo preservados, mas esta 
é uma transição mais contrastante do que o modo Soft Light / Luz Directa e menos radical 
do que o modo Hard Light / Luz Directa.

Soft Light / Luz Indirecta

Escurece ou aclara as cores, dependendo da cor aplicada (cor de mistura). O efeito é como 
aplicar uma fonte de luz difusa sobre a imagem.

Se a cor de mistura (que é como a fonte de luz) for mais brilhante do que 50 % de cinzento, 
a imagem fica mais “luminosa”, como se fosse aclarada. Se a cor de mistura for mais escura 
do que 50 % de cinzento, a imagem é escurecida. Pintar com branco ou preto puros produz 
uma área explicitamente mais clara ou escura, mas não resulta em branco ou preto puros.

Hard Light / Luz Directa

Aplica o efeito Multiply / Multiplicação ou Screen / Divisão, dependendo da cor aplicada (cor 
de mistura). O efeito é como aplicar uma fonte de luz intensa sobre a imagem.

Se a cor de mistura (que é como a fonte de luz) for mais brilhante do que 50 % de cinzento, 
a imagem fica mais “luminosa”, como se fosse aplicado o efeito Screen / Divisão. Isto é útil 
para adicionar tons claros (Highlights / Realces) a uma imagem. Se a cor de mistura for mais 
escura do que 50 % de cinzento, a imagem é escurecida, como se lhe fosse aplicado o efeito 
Multiply / Mutiplicação. Isto é útil para adicionar zonas escuras (Shadows / Sombras) a uma 
imagem. Pintar com branco ou preto puros resulta em branco ou preto puros.

Vivid Light / Luz Brilhante

Escurece ou aclara as cores aumentando ou diminuindo o contraste, dependendo da cor de 
mistura. Se a cor de mistura (que é como a fonte de luz) for mais brilhante do que 50 % de 
cinzento, a imagem fica mais “luminosa” ao diminuir o contraste. Se a cor de mistura for mais 
escura do que 50 % de cinzento, a imagem é escurecida pelo aumento do contraste.

Linear Light / Luz Linear

Escurece ou aclara as cores aumentando ou diminuindo a luminosidade, dependendo da cor de 
mistura. Se a cor de mistura (que é como a fonte de luz) for mais brilhante do que 50 % de cin-
zento, a imagem é aclarada através do aumento da luminosidade. Se a cor de mistura for mais 
escura do que 50 % de cinzento, a imagem é escurecida pela diminuição da luminosidade.

Pin Light / Luz do Pino

Substitui as cores, dependendo da cor de mistura. Se a cor de mistura (que é como a fonte de 
luz) for mais clara do que 50 % de cinzento, os pixéis mais escuros do que a cor de mistura 
são substituídos e os pixéis mais claros do que a cor de mistura não se alteram. Se a cor de 
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mistura for mais escura do que 50 % de cinzento, os pixéis mais claros do que a cor de mis-
tura são substituídos e os mais escuros do que a cor de mistura não se alteram. 

Hard Mix / Mistura Sólida

Esta nova mistura de cores, destaca-se pela posterização e contraste. A opacidade da cor da 
camada superior comanda a posterização e a cor que está a ser misturada na camada realça 
o contraste da cor.

Os restantes Modos de Mistura

Difference / Diferença

Analisa a informação de cor em cada canal e subtrai a cor de mistura da cor base ou a cor 
base da cor de mistura, dependendo de qual tenha o maior valor de brilho. A mistura com 
branco inverte os valores da cor base; a mistura com preto não produz alterações.

Exclusion / Exclusão

Cria um efeito semelhante, mas mais suave no contraste do que o modo Difference / Dife-
rença. A mistura com branco inverte os valores da cor base. A mistura com preto não produz 
alterações.

Hue /  Matiz

Cria uma cor resultante com a luminosidade e a saturação da cor base e a tonalidade da cor 
de mistura.

Saturation / Saturação

Cria uma cor resultante com a luminosidade e a tonalidade da cor base e a saturação da cor 
de mistura. Pintar neste modo numa área sem qualquer saturação (saturação com valor zero 
= cinzento) não produz qualquer alteração.

Color / Cor

Cria uma cor resultante com a luminosidade da cor base e a tonalidade e a saturação da 
cor de mistura. Isto preserva os níveis de cinzento na imagem e é útil para colorir imagens 
monocromáticas e para tingir imagens a cor.

Luminosity /Luminosidade

Cria uma cor resultante com a tonalidade e a saturação da cor base e a luminosidade da cor de 
mistura. Obtém-se o efeito inverso do conseguido com o modo Color / Cor.

Pass Through / Passagem – Um modo de mistura para conjuntos de camadas

Por predefinição, o modo de mistura de cor de um conjunto (ou pasta) de camadas (Layer 
set) é Pass Through (passagem), o que significa que o conjunto de camadas não tem pro-
priedades específicas de mistura de cores. Se escolhermos um modo de mistura de cores 
diferente para o conjunto de camadas, estaremos, efectivamente a mudar a ordem pela 
qual toda a imagem tem as suas cores misturadas. Todas as imagens do conjunto serão 
compostas entre si, primeiramente.

Depois, todo o conjunto de camadas é tratado como uma única imagem e misturado com 
o resto da imagem usando o modo de mistura seleccionado. No entanto, se escolhermos 
outro modo de mistura (que não Pass Through / Passagem) para o conjunto de camadas, 
nenhuma das camadas de ajustamento ou modos de mistura de cor dentro da pasta serão 
aplicados às camadas fora dessa pasta.
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AS PALETAS

O Photoshop apresenta várias paletas com diferentes funcionalidades. Sempre que pretende 
uma paleta que não está visível, vá ao menu Window, onde estão listadas todas as paletas, 
por ordem alfabética.

Para melhor “arrumação” no ecrã, as paletas podem ser agrupadas na mesma janela. 
Exceptuam-se as paletas Tools / Ferramentas, File Browser / Localizador de Arquivos e 
Options / Barra de Opções que não podem agrupar-se com outras paletas.

Quase todas as paletas apresentam uma seta 
no canto superior direito que abre um menu 
com comandos e operações diversos. A primei-
ra de todas as operações para (quase) todas 
as paletas é: Dock to Palette Well / Encaixar no 
Compartimento de Paletas, que permite colocar 
essa paleta num compartimento específico para 
paletas, à direita da Barra de Opções. Depois bas-
tará um clique na barra identificadora da paleta 
para abrir o seu conteúdo.

Outra função que muitas paletas possuem é a 
possibilidade de visualizar as miniaturas em dife-
rentes tamanhos ou mesmo ver apenas os nomes 
de cada uma.

Paleta Actions / Ações

A Paleta Actions / Ações funciona como um gravador, 
mas de acções. A partir do momento em que clica 
sobre o ícone New / Novo ( ) na base da paleta, todas 
as acções vão sendo gravadas, até ao momento em 
que fizer clique sobre o botão Stop ( ).

Depois, no botão Play / Executar Seleção ( ) , pode 
repetir esta acção nesta ou noutra(s) imagem(ns). Se 
seleccionar um comando a meio de uma acção e pre-
mir o botão Play / Executar Seleção ( ), a acção corre 
apenas desse ponto para a frente. Na seta do canto 
superior direito da paleta pode regravar uma acção, 
inserindo outros comandos. 

Pode criar pastas ( ) para agrupar acções. Se quiser 
apagar uma acção, basta arrastar para o caixote do 
lixo ( ) na base da paleta. Também pode arrastar 
para o lixo um comando individual de uma acção. E se 
desactivar um (ou mais) comando(s) de uma acção, ao 
correr, passará “por cima” desses comandos como se 
eles não existissem.

8765321 4

1 Activar/Desactivar.

2 Inserir Stop.

3 Parar a gravação.

4 Quando vermelho, indica que uma 
acção está a ser gravada.

5 Activar a Acção

6 Nova pasta para guardar acções

7 Nova Acção

8 Apagar a Acção
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Uma acção pode ser aplicada, de forma automática, a um conjunto de ficheiros e/ou pastas, 
através do menu File > Automate > Batch / Arquivo > Automático > Lote.

Pode guardar um conjunto de acções num ficheiro para carregamento posterior. 

Paleta Brushes / Pincéis

Esta paleta só fica disponível quando está seleccionada 
uma ferramenta que use este tipo de ponta (ferramen-
tas de pintura, retoque, etc.). Ela possui uma lista de 
brushes / pincéis disponíveis e ainda a possibilidade de 
os editar e/ou criar novos.

Por ser muito extensa, está normalmente “arrumada” no 
poço da paletas, do lado direito da barra de opções.

Paleta Channels / Canais

O programa armazena a cor nesta paleta, em canais 
separados. O número de canais depende do modo 
de cor; o modo RGB apresenta três canais (mais um 
canal “virtual” que é a junção dos três canais em 
que a imagem se compõe); o modo CMYK apresenta 
quatro canais; o modo Grayscale tem apenas um 
canal, etc.

Além dos canais de cor, existem ainda canais Alpha, 
que servem para guardar selecções que se pretende 
reutilizar. 

Há um terceiro tipo de canal: o canal Spot, onde pode guardar-se uma cor directa, e que só 
está disponível no modo CMYK.
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Paleta Character / Caractere 

Esta paleta contém formatação de caracteres. Muitos 
destes campos estão repetidos na barra de opções da 
ferramenta texto (veja página 27).

Paleta Color / Cor

A Paleta Color / Cor apresenta dois quadrados de 
cor correspondentes à cor Foreground / Cor do 
primeiro plano e cor Background / Cor do plano de 
fundo. Tanto pode mudar estas cores através dos 
quadrados na base da paleta de Ferramentas, como 
através da Paleta Color / Cor.

Esta Paleta apresenta, na base, um espectro de cor 
onde pode clicar para escolher uma cor. Se mover 
os deslizadores, modificará a cor seleccionada.

Paleta File Browser / Localizador de Arquivos

Esta paleta permite ver, de forma organizada, o 
conteúdo de pastas. Funciona de forma semelhante 
ao “Explorador”. Não pode ser agrupada com outras 
paletas.

Se fizer um duplo clique sobre uma (ou mais) das 
imagens visualizadas nesta janela, ela será aberta 
no Photoshop.

Para ter acesso a esta paleta, pode ir através do 
menu File > Browse / Arquivo > Procurar, ou atra-
vés do menu Window > File Browser / Janela > 
Localizador de Arquivo. Existe ainda a opção de 
fazer clique sobre o ícone desta paleta ( ), que 
se encontra sempre visível na Barra de Opções de 
qualquer ferramenta, no lado direito.

Pode aumentar ou diminuir a janela, mas o melhor será ampliá-la o máximo para maior como-
didade. É possível mudar o tamanho das três paletas na coluna da esquerda, fazendo clique 
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na linha divisória entre elas e arrastando. Pode também arrastar a linha vertical que divide a 
coluna da esquerda e a janela grande onde visualiza as miniaturas das imagens.

Podem seleccionar-se várias imagens em simultâneo para aplicar a todas a mesma transfor-
mação/alteração.

Paleta Histogram / Histograma

Esta paleta apresenta um histograma semelhante ao 
que surge no menu Image > Adjustments > Levels / 
Imagem > Ajustes > Níveis. Aqui, no entanto, é me-
ramente informativo, não permitindo quaisquer al-
terações. Tal como na janela dos níveis de cor, esta 
paleta apresenta os pixéis desde os mais escuros, à 
esquerda (0), até aos mais claros, à direita (255).

Através da setinha no canto superior direito pode 
activar as opções Expanded View / Visualização Ex-
pandida, e Show Statistics / Mostrar Estatísticas que 
mostra a informação dos dados em números; e a 
opção All Channels View / Visualização de Todos os 
Canais, como mostra a figura de baixo. 

Paleta History / Histórico

Esta paleta guarda todos os sucessivos “estados” da 
imagem activa, desde que se abre a ficheiro. O seu 
conteúdo é temporário e desaparece no momento 
em que fecha a imagem.

O número máximo de estados contidos na paleta 
pode ir até 1000, embora o valor predefinido com o 
programa seja de 20 estados (pode mudar-se atra-
vés das Preferências do programa).
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Paleta Info / Informações

Esta paleta tem carácter meramente informativo (não 
é possível mudar a informação nela exibida), mas é 
extremamente útil e deve estar sempre visível.

Ao mover o cursor sobre a imagem, a informação 
da(s) cor(es) surge na paleta como um densióme-
tro; esta leitura pode ser expressa no modo de cor 
escolhido pelo operador, na seta do canto superior 
direito da paleta. Numa segunda zona, a paleta 
mostra também as coordenadas do cursor e, se 
existir uma selecção activa, pode ver as medidas dessa selecção.
Se fizer medições de cor com a ferramenta Color Sampler / Classificador de Cores ( ), os 
valores surgem numa terceira zona, na parte inferior da paleta.

Paleta Layer Comps / Composições de Camada

A Paleta Layer Comps / Composições de Cama-
da permite guardar várias versões de um mesmo 
layout, geridas e visualizadas no mesmo ficheiro do 
Photoshop. 

Uma Layer Comps / Composições de Camada é um 
instantâneo de um estado da paleta Layers / Cama-
das. As composições podem registar três tipos de 
opções de camada (aceda às opções, no menu da 
paleta e escolha Layer Comps Options / Opções de 
Composição de Camadas):

•  Visibility / Visibilidade. A visibilidade da Layer / Camada, ou seja, se uma camada da paleta 
Layers / Camadas está visível ou oculta;

•  Position / Posição. A posição da camada no documento;

•  Appearance (Layer Style) / Aparência (Estilo da Camada). A aparência da camada, ou seja, se 
um estilo de camada está aplicado à camada.

Paleta Layers / Camadas

Existem cinco tipos de layers / camadas, que podem estar listados nesta paleta: 

- de imagem, contendo pixéis 

- de texto, com texto editável

-  de formas vectoriais, com uma cor de preenchimento e um path / demarcador que pode ser 
manipulado através das ferramentas de manipulação de paths / demarcadores

- de máscaras recortantes, também formadas por vectores (paths / demarcadores)

-  de ajustamento, que aplicam ajustes de correcção ou alteração de cor e que podem ser edi-
tados com um duplo clique.
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As camadas são movíveis (para cima ou para baixo) na paleta, podendo assim trocar a sua 
ordem relativa. Só uma layer / camada pode estar activa de cada vez; a camada activa é 
identificada por uma cor diferente, na paleta de camadas, e porque exibe o ícone de um 
pincel ao lado da miniatura. O nome da camada também aparece na barra de título, no topo 
da imagem.

A imagem de fundo / background é diferente de uma camada porque: 
- não se pode mover na paleta de camadas (ela é sempre a primeira imagem);
- não pode ter transparência;
- não se pode mudar a sua opacidade ou modo de mistura de cor.

Qualquer layer / camada pode ter uma máscara, que pode esconder total ou parcialmente o 
conteúdo da camada.
As camadas podem ser agrupadas com uma camada de baixo; neste caso, a camada na base 
do grupo serve de máscara de recorte à(s) outra(s), só sendo visível a área onde os conteúdos 
das camadas agrupadas se intersectam.
Pode também ligar camadas entre si, através do ícone da corrente. Isto significa que as cama-
das ligadas se movem e se transformam sempre juntas. Também se pode alinhar e distribuir 
camadas ligadas, através da barra de opções da ferramenta move / mover.
Para tornar visível/invisível uma camada, faça clique sobre o ícone do “olho”. Quando o olho 
está visível, o conteúdo da camada também é visível.

1. Modos de mistura de cor

2. Opções de bloqueio de camadas (respectivamente): 
transparência, imagem, posição, tudo

3. Camada de formas vectoriais

4. Grupo de recorte (esta camada só é visível na zona 
de intersecção com a camada inferior)

5. Link (camada “acorrentada” à camada activa)

6. Camada de texto

7. Conjunto de camadas (contém as duas camadas 
abaixo, que estão “desalinhadas” em relação às 
outras)

8. Camada de ajustamento

9. Ícone do pincel – indica que esta é a camada activa

10. Opacidade geral da camada activa

11. Opacidade só da camada, sem afectar a opacidade 
dos efeitos de camada

12. Mostrar/ocultar a barra de efeitos da camada

13. Barra de efeitos

14. Camada totalmente bloqueada

15. Máscara associada à camada de ajustamento

16. Máscara associada à camada

17. Camada parcialmente bloqueada

18. Ícone do olho – indica que a camada está visível

19. Novos efeitos 

20. Nova máscara

21. Novo conjunto de camadas

22. Nova camada de ajustamento ou de preenchimento

23. Nova camada de imagem

24. Lixo

1

2

3

4

5

6

7

8

9

10

11
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13

14

15
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Para criar uma camada (vazia) de imagem, faça clique sobre o ícone New / Novo ( ), na base 
da paleta. Para duplicar uma layer / camada, deve arrastá-la para cima deste ícone; surgirá 
uma cópia, com o mesmo nome da camada duplicada, seguido da palavra “copy”.
Para mudar o nome a uma camada, basta dar dois cliques sobre o seu nome e escrever.

No topo da paleta de camadas, pode mudar-se o modo de mistura de cor e a opacidade da 
camada activa. Pode também bloquear total ou parcialmente a camada, através dos ícones 

 .

Para colar a camada activa com a camada de baixo, faça clique na seta do canto superior 
direito e escolha Merge Down / Mesclar para baixo. Para colar todas as camadas, escolha, na 
mesma seta, Flatten Image / Achatar Imagem; neste caso deixa de ter camadas e todas ficam 
coladas na imagem Background / Imagem de Fundo.

Se tiver várias camadas ligadas, pode colar todas, escolhendo Merge Linked / Mesclar 
Vinculadas. E se tiver várias camadas escondidas, pode apagar todas de uma vez, através de: 
Delete Hidden Layers / Apagar Camadas Ocultas (todas estas opções se encontram na seta 
do canto superior direito da paleta Layers / Camadas).

Pode juntar camadas em pastas ( ), para arrumação da paleta e também para comodidade 
de trabalho: pode aplicar a uma pasta muitas das operações aplicáveis a camadas indivi-
duais, como apagar, colar todas, duplicar, arrastar para outra imagem, aplicar uma máscara, 
etc. Para criar uma pasta para layers / camadas, basta fazer clique sobre o ícone respectivo 
( ), na base da paleta; pode dar-lhe um nome e depois basta arrastar as layers / camadas 
que pretender para cima dela.

Para transformar o conteúdo da layer / camada activa, vá ao menu Edit > Transform / Editar 
> Transformar e escolha uma transformação. Também pode efectuar transformações livres 
através de Edit > Free Transform / Editar > Transformar Livremente (ou usar o atalho z / 
[Ctrl] + T).
Para fazer transformações com valores numéricos, pode dar entrada destes valores nos cam-
pos respectivos da barra de opções, depois de usar a transformação livre (z / [Ctrl] + T).

A uma layer / camada pode aplicar-se efeitos de camadas ou modos de mistura de cor, 
através do ícone , na base da paleta de camadas. Estes efeitos são editáveis e podem ser 
apagados arrastando-os para o caixote do lixo, na base da paleta.

Paleta Navigator / Navegador

Esta paleta permite “navegar” sobre a imagem 
activa. Sempre que a imagem está a ser mostrada 
maior do que a área visível, pode usar esta paleta 
para deslocar a imagem no ecrã. Esta paleta exibe 
um quadrado, geralmente vermelho, que ao ser 
arrastado move a imagem no ecrã. Para mudar a 
cor deste quadrado faça clique sobre a seta do 
canto superior direito e escolha Palette Options / 
Opções da Paleta.

Na base desta paleta pode também mudar a percentagem de visualização da imagem.
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Paleta Options / Opções

Esta Paleta (tal como todas as outras) está listada no menu Window / Janela. Ela tem, no en-
tanto, um aspecto diferente, por ser uma barra estreita (aliás, temo-nos vindo a referi-la como 
Barra de Opções). O seu conteúdo altera-se de acordo com a ferramenta em uso; por isso, 
existe uma explicação individual para cada ferramenta, no capítulo 2 - As Ferramentas.

Paleta Paragraph / Parágrafo

São aqui guardadas formatações relativas ao parágrafo, 
como o tipo de alinhamento do texto, espaço antes e 
depois do parágrafo, ligar/desligar a hifenização, etc.

Paleta Paths / Demarcadores

Sempre que cria um path / demarcador através 
da ferramenta Pen / Caneta ou de uma Shape / 
Forma Vectorial, ele surge nesta paleta, como work 
path / demarcador de trabalho. Como este path é 
temporário (desaparece no momento em que dese-
nhar outro), deve sempre dar-lhe um nome, para 
ficar guardado.  Para mudar o nome de um path / 
demarcador, basta fazer duplo-clique sobre o nome 
e escrever.

Na base da paleta, os diferentes ícones, permitem:

1. colorir o interior de um path / demarcador 

2. colorir o contorno de um path / demarcador

3. transformar um path / demarcador em selecção

4. transformar uma selecção em path / demarcador (só funciona com uma selecção activa)

5. criar um novo path / demarcador (vazio)

6. apagar o path / demarcador activo

Um path / demarcador pode ser seleccionado através da ferramenta de selecção de paths / 
demarcadores ( ). Para mover pontos de um path / demarcador, deve usar a ferramenta de 
selecção directa ( ). Para acrescentar ou retirar pontos, use a caneta+ ( +) ou a caneta – ( –), 
respectivamente. A ferramenta Convert Point / Conversora de pontos ( ) converte um ponto  
“bicudo” num ponto redondo e o inverso.

65431 2
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Para transformar um path / demarcador em demarcador de corte, por forma a ocultar toda a 
imagem que está fora do recorte, ao ser colocado num programa de paginação, deve selec-
cionar o path / demarcador e ir à seta no canto superior direito da paleta; active a opção 
Clipping Path / Demarcador de Corte e escolha qual o path / demarcador que vai recortar a 
imagem. Podem existir muitos paths / demarcadores na mesma imagem, mas só um pode 
ser clipping / de corte.

Paleta Styles / Estilos

Aqui pode guardar efeitos aplicados a layers / 
camadas e/ou modos de mistura de cores, para 
aplicar, de forma fácil, a outras layers / camadas. 
É outra biblioteca, mas neste caso de estilos de 
camadas.

Para guardar um estilo aplicado a uma camada, bas-
ta fazer clique numa área vazia da paleta, ou fazer 
clique sobre o ícone New / Novo ( ), na base.

Se quiser apagar um estilo que guardou anterior-
mente, deve seleccioná-lo e fazer clique sobre o caixote do lixo ( ), na base da paleta.

Para guardar os estilos da paleta num ficheiro que possa carregar mais tarde, para usar noutras 
camadas, clique na seta do canto superior direito e escolha Save Styles / Guardar Estilos.

Paleta Swatches / Amostras 

Esta paleta é uma biblioteca de cor, onde pode 
guardar cores que pretenda usar novamente. Basta 
fazer clique numa área vazia da paleta para guardar 
a cor foreground / cor do primeiro plano, ou faça 
clique sobre o ícone New / Novo ( ), na base da 
paleta.

Se quiser apagar uma cor guardada nesta paleta, 
clique com a tecla [Alt], ou arraste essa cor para 
cima do caixote do lixo ( ), na base da paleta.

Para guardar todas as cores da paleta num ficheiro que possa carregar mais tarde, para usar 
noutras imagens, clique na seta do canto superior direito e escolha Save Swatches / Guardar 
Amostras.
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Paleta Tool Presets / Predefinições para Ferramentas

Nesta paleta podem guardar-se predefinições para 
ferramentas que pode usar posteriormente. Elas 
estarão disponíveis não só nesta paleta, mas tam-
bém com um clique sobre o ícone da ferramenta, na 
Barra de Opções de cada ferramenta.

Através do menu Edit > Preset Manager / Editar 
> Gerenciador de Predefinição, também pode ter 
acesso aos conjuntos de predefinições para as fer-
ramentas.

Para apagar uma predefinição, basta arrastar para o caixote do lixo ( ), na base da paleta. 
Para guardar as definições correntes da ferramenta em uso, faça clique sobre o ícone New / 
Novo ( ), na base da paleta.

Paleta Tools / Ferramentas

A Paleta Tools / Ferramentas (também, chamada Barra de Ferramentas) está 
explicada em detalhe no início deste manual, a partir da página 3.
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OS MENUS

O Photoshop CS, em sistema Mac OSX, tem mais um menu do que em Windows; trata-se do 
menu Photoshop (o primeiro menu), que contém opções extras (serviços) do sistema que fun-
cionam directamente no Photoshop.

Neste manual vamos seguir a ordem do sistema Mac OSX, assinalando sempre as diferenças 
para Windows.

Menu Photoshop

About Photoshop / Sobre o Photoshop

Abre a janela inicial do programa Photoshop, onde 
mostra a versão instalada. Basta fazer clique sobre 
a janela para a fechar. Em Windows, esta opção está 
no menu Help / Ajuda.

About Plug-Ins / Sobre Plug-Ins

Mostra uma lista com todos os plug-ins instala-
dos. Para ver a informação disponível de cada um, 
basta fazer clique. Em Windows, esta opção está 
no menu Help / Ajuda.

Color Settings / Configurações de Cor

Abre uma janela onde pode editar as 
especificações de cor que o programa 
vai usar na gestão de cor do documento 
activo (em Windows, esta opção encon-
tra-se no menu Edit). Aqui pode definir 
os perfis de cor que pretende (também 
chamados Working Spaces / Espaços 
de Trabalho) e as configurações guar-
dadas servirão para marcar (“tag”) a 
imagem com o perfil ICC do espaço de 
trabalho. Esta marca é também utiliza-
da para fixar as regras de política de 
gestão de cor relativamente ao que su-
cede quando trabalha com um ficheiro 
que não tem embutido qualquer perfil 
ICC ou tem um que não coincide com o 
espaço de trabalho de cor que o opera-
dor definiu.
Ao passar com o cursor sobre os dife-
rentes campos da janela, pode ver uma 
descrição resumida de cada um na par-
te inferior, no campo Description.
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Preferences / Preferências

As preferências são definições que se aplicam ao programa como um todo. Esta janela divide-
se em vários paineis:

• General / Geral

Neste painel pode estabelecer predefinições para a actuação do programa. Pode escolher:

• o Painel de Cores a usar;

•  o método de interpolação (ou 
seja, qual o processo usado 
ao refazer uma imagem), al-
terando o seu tamanho ou a 
sua resolução;

•  o número de estados da pa-
leta History / Histórico; 

No campo Opções (Options), 
pode activar/desactivar as se-
guintes:

•  exportar conteúdo da memó-
ria temporária (Clipboard); 

•  mostrar etiquetas (Tool Tips); 

•  refazer automaticamente o 
tamanho da janela ao mu-
dar a visualização; 

•  actualizar automaticamente 
documentos abertos; 

•  mostrar opções de texto asiático; 

•  activar sons ao terminar cada comando; 

•  activar os deslizadores de cor para mostrar todas as cores possíveis; 

•  memorizar localização das paletas; 

•  mostrar os nomes das fontes em inglês; 

•  usar a tecla Shift para alternar entre ferramentas relacionadas; 

• us ar aspas curvas

Se activar a opção History Log, pode guardar as informações registadas na Paleta History com 
os metadados da imagem, ou num ficheiro de texto. 

O botão Reset All Warning Dialogs serve para limpar os diálogos de aviso, ou seja, algumas 
caixas de diálogo avisadoras contêm a opção Don’t Show this Dialog Again (Não Mostrar No-
vamente). Ao limpar os diálogos de aviso, fá-los aparecer novamente.
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• File Handling / Painel de opções para ficheiros

Este painel permite definir algumas políti-
cas para lidar com os ficheiros de imagens:
incluir ou não previsualização e se acres-
centa extensão ao ficheiro (no caso dos uti-
lizadores de Windows, a opção é escolher 
se a extensão é em maiúsculas ou minús-
culas).

O campo da compatibilidade de ficheiros 
tem opções para: 

•  ignorar a especificação do espaço de cor 
guardada com metadados;

•  perguntar antes de salvar ficheiros TIFF 
com camadas; 

•  activar Formato de Documento Grande 
(.psb), que permite salvar documentos mui-
tos grandes não compatíveis com versões 
anteriores; 

•  maximizar a compatibilidade de arquivos 
PSD (nunca, sempre ou perguntar).

Pode, ainda activar a Version Cue (funcionamento em rede), e determinar quantos ficheiros sur-
gem na lista de documentos recentes.

• Display & Cursors / Painel de opções para visualização e cursores

Este painel tem uma área rela-
tiva à visualização (Display), 
outra para definir o aspecto dos 
cursores de pintura (Painting 
Cursors) e outra para os outros 
cursores (Other Cursors)
Pode activar:
•  mostrar os canais de cores co-

loridos;
•  visualizar transições mais 

suaves entre cores, especial-
mente em monitores a 8 bits, 
simulando cores que o Pho-
toshop não consegue mos-
trar, através de uma difusão 
dos pixéis; 

•  usar a duplicação de pixéis. 
Para os cursores de pintura (painting cursors), pode escolher os aspectos da ferramenta em 
uso; em forma de uma pequena cruz ou o tamanho da brush escolhida. Em outros cursores 
(Other Cursors) têm apenas as duas primeiras opções – Standard e Precise.
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• Transparency & Gamut / Painel de opções para transparência e gama de cor

Neste painel, escolha o ta-
manho dos quadradinhos 
com que o programa re-
presenta a transparência; 
determine as cores do qua-
driculado que representa a 
transparência; envie infor-
mação de transparência ao 
usar um cartão de vídeo de 
32 bits e escolha a cor com 
que o Photoshop vai colorir 
as zonas da imagem que es-
tejam fora da gama (Out-of-
Gamut) quando a imagem é 
convertida para CMYK. Deve escolher uma cor que não esteja presente na imagem, para fácil 
identificação.

• Units & Rulers / Painel de opções para unidades de medida e réguas

Neste painel pode escolher a unidade de 
medida a utilizar nas réguas de topo e late-
ral; a unidade de medida para definição do 
corpo (tamanho de letras) do texto; os valo-
res para medidas de coluna: largura (width) 
e intervalo entre colunas (gutter), que po-
dem ser fornecidos nas mesmas unidades 
de medida usadas para as réguas; determi-
nar a resolução de impressão (geralmente 
300 dpi); determinar a resolução no ecrã 
(geralmente 72 dpi) e a definição do ponto 
de pica com os valores para PostScript (72 
pontos/polegada) ou com os valores tradi-
cionais (72.27 pontos/polegada).
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• Guides, Grid & Slices / Painel de opções para guias, grelha e fatias

Neste painel pode escolher as cores e os estilos 
para as guias, grelhas e fatias.

• Plug-Ins & Scratch Disks / Painel de opções para extensões e discos de apoio

O termo Plug-In designa, normalmente, uma 
extensão, um módulo ou uma aplicação. No 
Photoshop, as preferências referentes a Plug-
Ins dizem ao programa onde encontrar ex-
tensões adicionais, como Filtros. Os Filtros 
que vêm com o programa estão instalados 
na pasta do programa, mas nesta janela po-
demos definir uma pasta para colocar filtros 
adicionais. As preferências referentes a Scra-
tch Disks (discos de apoio) dizem ao progra-
ma onde pode armazenar ficheiros temporá-
rios. Se tiver vários discos, deve designar o(s) 
mais rápido(s) para uma boa performance.

•  Memory & Image Cache / Painel de opções para memória e cache de imagem

A Cache de imagem acelera a visualização 
das imagens, ao trabalhar com ficheiros mui-
to grandes.  Cololoque a percentagem de me-
mória total usada pelo Photoshop. As opções 
desta janela ficarão activas apenas da próxi-
ma vez que entrar no programa.
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•  File Browser / Localizador de Arquivos

Neste painel define-se regras de funcionamento do File Browser / Localizador de Arquivos:

•  tamanho máximo dos fichei-
ros a serem processados;

•  mostrar quantas pastas usa-
das recentemente;

•  tamanho da miniatura de ca-
da imagem;

Nas Opções (Options) pode ac-
tivar:

•  permitir processamento em 
segundo plano, usando uma 
memória de processamento 
extra.

• visualização de imagens em alta qualidade;

•  visualizar imagens vectoriais;alizadas as imagens de vectores.

• |visualizar e editar os metadados de ficheiros que não são imagem (texto e outros).

•  manter arquivos secundários XMP e THM junto com o ficheiro principal. Ficheiros secundá-
rios ajudam outros programas a processarem os metadados associados a um ficheiro.

Services / Serviços

Mostra um submenu com opções e acções do sistema usadas em alguns programas. O Pho-
toshop não usa este submenu.

Hide Photoshop / Ocultar Photoshop 

Permite esconder só o Photoshop.

Hide Others / Ocultar Outros

Permite esconder todos os programas activos excepto o Photoshop.

Show All / Mostrar Tudo 

Mostra todos os Programas activos.

Quit Photoshop / Encerrar Photoshop 

Sai do Photoshop, fechando todos os documentos abertos. O operador tem oportunidade de 
salvar as alterações que tenha feito.
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Menu File / Arquivo

New / Novo
Abre uma janela com especificações para uma nova imagem, 
como o tamanho, a resolução e o modo de cor. Se tiver feito 
um comando Copy / Cópia anteriormente, esta janela abre 
com os dados dessa cópia.

Open / Abrir
Abre uma listagem de ficheiros para escolher o que se preten-
de abrir.

Browse / Navegar
Abre a janela File Browser / Localizador de Ficheiros, onde 
pode fazer duplo-clique sobre um ficheiro para o abrir.

Open As / Abrir como (apenas em ambiente Windows)

Pode abrir um ficheiro com um formato específico (Tiff, EPS, 
etc.) Em Macintosh, esta possibilidade existe directamente no 
menu Open (abrir).

Open Recent / Abrir Recentes
Mostra uma lista com os últimos ficheiros abertos.

Edit in Image Ready / Abrir no Image Ready
Abre o documento activo no Image Ready.

Close / Fechar
Fecha o documento activo. Se tiver feito alterações desde o 
último Save / Salvar, surge uma janela a perguntar se pretende guardar estas alterações.

Close All / Fechar todos
Fecha todos os documentos activos. Se tiver feito alterações desde o último Save / Salvar, 
surge uma janela a perguntar se pretende guardar estas alterações.

Save / Salvar
Salva o ficheiro aberto, com as últimas alterações. A primeira vez que fizer Save a um ficheiro 
novo, o programa abre uma janela para lhe dar um nome, um formato e uma pasta de destino. 
As vezes seguintes, regrava as alterações sobre a versão original. 

Save As / Salvar Como
Permite salvar o ficheiro com as últimas alterações, especificando a pasta (e a drive), o nome 
e o formato do ficheiro.

Save A Version / Salvar uma Versão
Guarda uma versão do ficheiro directamente no servidor de rede ou na internet, conforme 
estiver programado.
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 Save for Web / Salvar para a Web

Abre uma janela que permite optimizar a imagem de acordo com especificações e formato 
adequados à utilização na Web.

Revert / Reverter

Permite voltar à última versão do ficheiro activo que foi guardada. 

Place / Colocar

Permite colocar sobre a imagem um ficheiro com formato EPS ou PDF.

Online Services... / Serviços On-line...

Abre uma janela com uma lista de serviços on-line da Adobe. 

Import / Importar

Acesso a imagens vindas de scanners ou máquinas digitais. As opções disponíveis dependem 
dos dispositivos instalados.

Export /Exportar

Exporta os paths do documento para os programas Illustrator ou Freehand. Deste submenu 
também se podem exportar ficheiros para o formato ZoomView que se destina a imagens de 
alta resolução para a Web.

Automate / Automatizar

Este comando simplifica tarefas complexas, combinando a sua automatização.

• Batch / Quantidade
Aplica uma acção com diversos comandos a todos os ficheiros de uma pasta e subpastas, 
de forma automática.

• PDF Presentation / Criar Apresentação de PDF
Este comando permite utilizar várias imagens para criar um documento PDF com várias pá-
ginas ou uma Apresentação de Slides. 

• Create Droplet / Criar Droplet
Uma Droplet é uma miniaplicação contendo uma acção, que pode ser guardada numa 
pasta. Basta depois arrastar para cima deste ícone um ficheiro (ou vários), ou mesmo uma 
pasta com ficheiros, o que aplica automaticamente a acção sobre esse(s) ficheiro(s).

• Conditional Mode Change... / Alterações Condicionais
Permite alterar o modo de cor de um documento, para o modo que se escolher.

• Contact Sheet II / Folha de Contacto II
Permite criar uma espécie de “índice visual”, ao agrupar miniaturas de todas as imagens 
de uma pasta numa página, podendo acrescentar legendas automáticas.

• Crop and Straighten Photos / Cortar e Corrigir Fotos
Corta, separa e corrige inclinações de várias fotos digitalizadas em conjunto.

• Fit Image / Tamanho máximo de imagem
Fixa um tamanho máximo para a imagem. Ajusta a imagem actual à largura e altura es-
pecificadas. Funciona em pixéis.

• MultiPage PDF to PSD / Ficheiro PDF com várias páginas para ficheiro PSD
Transforma um ficheiro PDF, com várias páginas, em vários ficheiros Photoshop PSD (tan-
tos ficheiros PSD quantas páginas tiver o ficheiro PDF).
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• Picture Package / Pacote de imagens
Coloca várias cópias da mesma imagem (ou de várias imagens) numa só página. 

• Web Photo Gallery / Galeria de imagens para a Web
Serve para criar uma galeria de fotos para a Web a partir de um conjunto de imagens. Esta 
galeria funciona como um site, contendo uma home page com miniaturas de imagens.

• Photomerge
Permite fazer montagens de várias fotos, como, por exemplo, várias perspectivas da 
mesma panorâmica.

Scripts

Através deste submenu é possível usar scripts internos novos ou personalizados, para automa-
tizar e versatilizar tarefas repetidas.

File Info / Informação sobre o ficheiro

Janela onde pode guardar e editar informação relativa ao ficheiro activo (nome, autor, traba-
lho, etc.).

Versions  / Versões

Informação sobre as diferentes versões do ficheiro guardadas na rede de trabalho ou na Inter-
net, conforme as definições do projecto VersionCue.

Page Setup / Definições de Página

Abre uma janela onde se podem alterar as especificações da página para impressão (medidas, 
orientação, etc.).

Print with Preview / Impressão com pré-visualização

Abre uma janela onde se pode pré-visualizar o documento e editar as especificações para 
impressão. 

Print / Impressão

Abre a janela de impressão do documento, onde pode escolher a impressora (no caso de ter 
mais de uma instalada) e ainda o nível de qualidade para a impressão da sua imagem. 

 Print One Copy / Impressão de uma cópia

Imprime automaticamente uma cópia do documento.

Jump To / Ir para

Passa para o programa Image Ready, que vem sempre com o Photoshop, e que se destina a 
edição e tratamento de imagens para a Web.

Quit / Sair

Sai do Photoshop, fechando todos os documentos abertos. O operador tem oportunidade de 
salvar as alterações que tenha feito (no sistema X de Macintosh, esta opção situa-se no menu 
Photoshop).
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Menu Edit / Editar

Undo / desfazer

Desfaz a última operação efectuada. Despois de desfazer e 
antes de executar qualquer operação, terá disponível o co-
mando Redo / Refazer para refazer a última operação. 

Step Forward / Um passo à frente

Anda um “passo” para a frente após a operação, comando 
ou aplicação de ferramenta actual. É o mesmo que fazer 
clique sobre o estado seguinte na Paleta History / Histó-
rico. Este submenu está normalmente indisponível, a me-
nos que tenha já “andado para trás”.

Step Backward / Um passo atrás

Anda um “passo” para trás, ou seja, antes da última ope-
ração, comando ou aplicação de ferramenta, como se an-
dasse para trás um estado da Paleta History / Histórico.

Fade / Atenuar

Altera a intensidade do último filtro aplicado ou do último 
ajuste de cor aplicado através do menu Image > Adjust-
ments.

Cut / Cortar

“Corta” a área seleccionada, da camada activa, e coloca-a 
em memória, podendo depois ser recolocada com o comando Paste / Colar, nesta ou noutra 
imagem. Este comando “apaga” a selecção da imagem original.

Copy / Copiar

Copia a área seleccionada, da camada activa, e coloca-a em memória, podendo depois ser 
recolocada com o comando Paste / Colar, nesta ou noutra imagem.

Copy Merged / Copiar Mesclado

Copia a área seleccionada, de todas as camadas, e coloca-a em memória como uma só ima-
gem fundida, podendo depois ser recolocada com o comando Paste / Colar, nesta ou noutra 
imagem.

Paste / Colar

“Cola” uma cópia da imagem que estiver em memória (Clipboard) no documento activo.

Paste In / Colar Em

“Cola” uma cópia da imagem que estiver em memória, dentro da área seleccionada na camada 
activa, criando uma máscara automática para essa camada.
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Clear / Apagar

Apaga o conteúdo da área seleccionada, na camada activa.

Check Spelling... / Verificar a Ortografia

Janela para verificar a ortografia das camadas de texto da imagem.

Find and Replace Text... / Procurar e Substituir texto

Janela para procurar e substituir texto nas camadas de texto da imagem.

Fill... / Preencher

Permite preencher uma selecção ou camada com: a cor Foreground / cor do Primeiro Plano, a 
cor Background / cor do Plano de Fundo, uma outra cor escolhida no Color Picker / Seletor de 
Cores, um padrão, um estado da Paleta History / Histórico e ainda preto, branco ou cinzento. 
Todas estas opções podem ser aplicadas com diferentes opacidades e modos de mistura de 
cor (blending modes).

Stroke... / Traçar

Abre uma janela onde especifica a espessura e a localização (dentro, fora ou no meio da linha 
limitadora) do traço que vai contornar a selecção activa. Pode ainda aplicar este traço com 
diferentes opacidades e modos de mistura de cor  (blending modes). 

Free Transform / Transformação livre

Permite transformar a área seleccionada ou a camada activa, que surge rodeada de uma caixa 
limitadora com oito pegas e um ponto central. Este ponto central pode ser deslocado e a área 
ou a camada podem ser redimensionadas, rodadas ou distorcidas através das pegas.

Transform / Transformação

Abre uma lista de transformações específicas (escalar, rodar, torcer, inverter, etc.) para que o 
operador escolha a que pretende aplicar à selecção ou camada activa.

Define Brush Preset / Definir Predefinição de Pincel

Faz com que a área que estiver seleccionada ou toda a imagem (se não houver uma selecção), 
fique como um novo brush/pincel, que ficará disponível na Paleta Brushes para ser usado com 
qualquer ferramenta de pintura ou retoque.

Define Pattern / Definir Padrão

Guarda a área seleccionada (ou toda a imagem), num novo padrão (Pattern) que ficará disponí-
vel para ser usado com o comando Fill (menu Edit > Fill > Pattern), com a Ferramenta do Balde 
de Tinta ( ) ou com o Carimbo com padrão ( ). A selecção para definir um padrão tem de 
ser uma área quadrada, ou rectangular, e sem Feather/Difusão.

Define Custom Shape / Definir Forma Personalizada

Guarda o path/demarcador activo como uma nova forma vectorial, guardada na paleta respectiva.

Purge / Descartar

Apaga da memória do programa (Clipboard), a última cópia, os estados da Paleta History, os 
Undo ou todos estes. Liberta memória, optimizando o desempenho do programa.
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Keyboard Shortcuts / Atalhos de Teclado

Aqui, pode personalizar teclas de atalho conforme desejar, tanto atalhos individuais como 
definir conjuntos de atalhos personalizados.

Preset Manager / Gerenciador de Predefinição

Abre uma janela onde o operador pode gerir as predefinições para Brushes/Pinceis, Swatches 
/Amostras de cor, Gradients / Degradês, Styles / Estilos, Patterns / Padrões, Contours / Rele-
vos, Custom Shapes / Formas Vectoriais e Tools / Ferramentas. As predefinições para as fer-
ramentas também estão acessíveis se fizer clique sobre o primeiro ícone na Barra de Opções 
(ícone da ferramenta em uso). 

Menu Image / Imagem

Mode / Modo

Este submenu permite mudar o modo de cor da imagem para um dos oito seguintes:

• Bitmap
Modo em que todos os pixéis são pretos ou brancos (com ape-
nas um bit – on ou off). É usado em imagens a traço (como 
desenhos a tinta-da-china), logótipos, etc. 
Ao converter uma imagem para modo Bitmap (sempre a partir 
de uma imagem em Grayscale), surge uma janela onde é pos-
sível determinar uma nova resolução para a imagem, além de 
escolher entre quatro tipos de conversão: 
– 50 % Threshold – converte para preto todos os tons de cinzen-
to com mais de 50 % de preto e para branco todos os tons com 
menos de 50% de preto; 
– Pattern Dither – a imagem é convertida pela aplicação de um 
padrão que simula os tons de cinzentos. Para um efeito mais 
próximo daquele em tons de cinzento, utilize Diffusion Dither; 
– Diffusion Dither – Os pixéis são espalhados por forma a simu-
larem os tons de cinzento; 
– Halftone Screen – Os tons de cinzento são simulados através de pontos em meios-tons, 
sendo aqui necessário escolher valores para Frequency (frequência) que determina o tama-
nho dos pontos, Angle (ângulo) e Shape (forma) do ponto, que pode ser Round (redondo), 
Diamond (em forma de diamante), Ellipse (elíptico), Line (linha), Square (quadrado) ou Cross 
(cruzado); 
– Custom Pattern – preenche as áreas da imagem com mais de 50 % de preto, usando um 
padrão seleccionado entre os padrões disponíveis. 

• Grayscale
As imagens em modo Grayscale contêm uma gama de 256 tons de cinzentos, que vão 
desde 0 (preto – ausência total de luz) até 255 (branco – a luz total). Ao converter uma ima-
gem para o modo Grayscale a informação de cor é removida. Aparece uma janela de alerta 
Discard color information? (descartar a informação de cor?); faça clique no botão [OK] e a 
cor é retirada; a imagem passa a ter apenas um canal.

• Duotone
Um Duotone pode ser do tipo Monotone (uma só cor), Duotone (duas cores), Tritone (três 
cores) ou Quadtone (quatro cores). Independentemente do tipo, os Duotones são sempre 
tratados como imagens em tons de cinzento, com um único canal. Por isso, não é possí-
vel aceder aos ajustamentos de cor em canais separados, como acontece com as imagens 
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em RGB, CMYK e Lab. Em vez disso, pode 
utilizar as curvas do próprio Duotone, às 
quais tem acesso pelo processo idêntico ao 
de converter a imagem para Duotone: menu 
Image > Mode > Duotone. Surge a janela de 
opções do Duotone, onde pode escolher o 
tipo de Duotone (que determina quantas co-
res são usadas), e ainda qual (ou quais) a(s) 
cor(es) (estas podem ser directas ou separa-
das). Se fizer clique sobre a curva do lado 
esquerdo do quadrado de cor, tem acesso à 
curva para edição da cor. Se preferir, pode 
usar as combinações de Duotones prede-
finidas que o Photoshop contém na pasta 
Presets / Duotones, fazendo clique sobre o 
botão [Load]. Estas predefinições estão divididas em três pastas, correspondentes a os três 
tipos: Duotones, Tritones e Quadtones.
Uma imagem em modo Duotone tem de ser gravada no formato EPS ou PDF.

• Indexed Color
Uma imagem em Indexed Color (cor indexada) contém apenas um canal e uma tabela de 
cor que pode conter um máximo de 256 cores, o preto corresponde ao nível 0 e o branco 
ao  nível 255. Pode escolher uma paleta de cores a usar na imagem indo a Menu > Mode > 
Color Table. Ver a explicação mais à frente.

• RGB
É o modo de cor mais comum e também o mais versátil, já que é o único em que funcionam 
todas as opções das ferramentas e todos os filtros. A cor é guardada em três canais: um 
para o vermelho (Red), um para o verde (Green) e um para o azul (Blue). Na Paleta de Canais 
visualiza-se ainda mais um canal (RGB), mas não corresponde a um canal real: é apenas a 
representação de como os três canais são vistos em conjunto. Cada canal tem 8 bits por 
pixel, o que se traduz em 256 níveis de brilho por canal. Cada pixel, contém três valores 
de brilho (um para cada cor), de 0 a 255. Quando todos apresentam o valor 0 (zero), a cor 
reproduzida é preto. Para três valores de 255, a cor apresentada é branco. O valor máximo 
de cada uma das três cores (255) corresponde à luz total. 

• CMYK
Modo de cor usado para impressão a quatro cores separadas (cada cor – ou canal – corres-
ponde a uma chapa de impressão). Cião, magenta e amarelo são as cores complementares 
de vermelho, verde e azul. Na Paleta de Canais, vemos ainda mais um canal “virtual”, que 
representa a imagem com todos os canais juntos. Se juntarmos as três cores (cião, magenta 
e amarelo) obtemos preto. Para reproduzirmos o preto em impressão, no entanto, é necessá-
rio juntar uma tinta preta (Black), já que o tom de preto obtido pela adição das três cores é 
“baço”. No modo CMYK, as cores são armazenadas em quatro canais e os valores são expres-
sos em percentagem, correspondendo à quantidade de tinta que o impressor vai usar. 

• Lab
As imagens em modo Lab têm três canais: um para o brilho ou luminosidade, um canal “a” 
com as cores verde a vermelho e um canal “b” com as cores azul a amarelo. À semelhança 
do que se passa em CMYK e RGB, vemos ainda mais um canal “composto”, que na realidade 
não existe, mas que mostra a imagem com a sua cor final, ou seja, com todos os canais.
O espaço de cor Lab é independente de qualquer dispositivo e é o maior de todos os espa-
ços, representando todas as cores que o olho humano pode captar. 

• Multichannel
Uma imagem em modo Multichannel (multicanais) contém vários canais e nenhum canal 
composto, ao contrário do que acontece em RGB, CMYK e Lab. Para passar a modo Multi-
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channel, além do processo comum de escolher este modo de cor através do menu Image > 
Mode, também pode, em alternativa, apagar um canal (estando em RGB, CMYK ou Lab) e a 
passagem é automática. Se converter uma imagem RGB para modo Multichannel, os canais 
Red, Green e Blue, são convertidos em Cian, Magenta e Yellow. Se a imagem tiver canais 
Spot (canais de cor directa), eles são preservados na conversão. Apenas uma imagem com 
vários canais pode ser passada a modo Multichannel. É um modo usado apenas em situa-
ções muito particulares de impressão.

• 8 Bits / Channel 
Converter para 8 bits imagens que cheguem ao Photoshop com 16 bits por canal (por 
exemplo, imagens provenientes de algumas máquinas fotográficas digitais e de certos 
scanners). Estes ficheiros contêm o dobro da informação em termos de cor, permitindo uma 
maior profundidade e, por isso, mais detalhe.
Embora o Photoshop consiga ler imagens a 16 bits por canal, muitos dos comandos não 
funcionam nesta profundidade, sendo necessário baixar a imagem para 8 bits por canal. 
Pode, no entanto, aproveitar a imagem enquanto ainda em 16 bits para fazer ajustamentos 
de cor (menu Image > Adjustments).

• 16 Bits / Channel
Pode mudar-se uma imagem de 8 para 16 bits, mas isso não traz qualquer melhoria à ima-
gem e duplica o seu “peso” em disco. 

• Color Table
A tabela de cor (Color Table) só está disponível para o modo Indexed Color e é a forma de 
editar os valores de cor, já que este modo utiliza apenas um canal.
No menu à frente de Table pode escolher uma tabela predefinida. A grelha com os qua-
drados de cor, contém todas as cores do ficheiro indexado. Se fizer clique sobre um dos 
quadradinhos pode alterar os seus valores no Color Picker / Seletor de cores.

• Assign Profile / Atribuir Perfil
Use este menu sempre que queira ver como é que a imagem ficaria usando um outro perfil 
de cor. Na janela que surge, pode escolher:

•  Don’t Color Manage This Document / Não efetue Gerenciamento de Cores neste Docu-
mento;

•  Working Space / Espaço de Cor Corrente: é a segunda opção, trabalhar a imagem de acordo 
com as definições escolhidas para o espaço de trabalho corrente;

•  Profile / Perfil: faça clique sobre esta listagem para escolher qualquer outro perfil.

Este comando pode ser particularmente útil se pretende ver como a imagem vai ser impres-
sa numa dada impressora, por exemplo, bastando atribuir o perfil dessa impressora, para 
ver o resultado final. 

• Convert to Profile / Converter para Perfil
Se pretender alterar o perfil da imagem, vá ao menu Image > Mode > Convert to Profile.
No topo da janela que surge, está indicado o perfil original (Source Space), e no campo 
Destination Space (espaço ou perfil de destino), à frente de Profile, pode escolher, de uma 
lista que se desenrola, o novo perfil a atribuir. 

Adjustments / Ajustamentos

• Levels / Níveis
Este comando permite recolocar os valores de cor de uma imagem manipulando os contro-
los que representam os seus tons escuros, meios-tons e tons claros (ou brilhos). Ao mover 
os deslizadores de Levels e referindo-nos ao histograma – um gráfico que reflecte os dados 
da imagem – é possível comprimir, expandir ou fixar a gama tonal existente.
Na janela de Levels, à frente do campo Channel, pode escolher qual o canal de cor em que 
pretende fazer ajustamentos ou trabalhar em todos os canais ao mesmo tempo.
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Os níveis de Input (Input Levels) cor-
respondem, da esquerda para a direi-
ta, aos valores de sombras, ou tons 
escuros (de 0 a 253); aos valores dos 
meios-tons (de 9.99 a 0.10); e aos va-
lores dos tons claros ou brilhos (de 2 
a 255). Um valor no campo do meio 
superior a 1, aclara os meios-tons da 
imagem, enquanto um valor inferior 
os escurece, tudo isto sem alterar os 
pontos branco ou preto.
Os níveis de Output restringem os va-
lores máximos de tons claros e escuros 
na imagem. No fundo, é uma forma de 
compressão da gama tonal.
Todas as imagens possuem um ponto 
preto e um ponto branco. O ponto preto é o valor abaixo do qual 
os pixéis não apresentam detalhe. O ponto branco determina o 
valor acima do qual os brancos são branco puro, sem detalhe.
Através da pipeta mais escura (primeira da esquerda), pode 
determinar-se outro ponto preto; a pipeta mais clara (última) 
serve para determinar outro ponto branco. As imagens a cores 
apresentam ainda uma pipeta no meio, correspondente ao cin-
zento neutral.

•  Auto Levels / Auto Contrast / Auto Color Correction / Níveis, Contraste e Correc-
ção de Cor automáticos
Na listagem à frente de Image > Adjustments, os três submenus seguintes são: Auto Levels 
(níveis automáticos), Auto Contrast (contraste automático) e Auto Color (correcção de cor 
automática). Estes três comandos aplicam correcções automáticas; este último só está dis-
ponível para imagens no modo RGB. 
Para regular as especificações destes comandos, o operador pode ir à caixa de diálogo dos 
níveis de cor (Image > Adjustments > Levels) ou à caixa de diálogo das curvas (Image > 
Adjustments > Curves), e fazer clique sobre o botão [Options].

•  Curves / Curvas
Possibilita os mesmos ajustamentos que o submenu Levels, e ainda ajustes específicos a 
determinadas gamas de cor, mas em vez de usar um histograma, estes ajustes são feitos 
através de uma curva. 
A linha diagonal pode ser alterada (curvada) através de pontos que se fixam e arrastam ao 
longo da linha. Movendo a parte inferior esquerda da linha altera os tons escuros; o meio 
da linha refere-se aos meios tons e a parte superior direita regula os tons claros, como se 
pode perceber pela gradação das barras exteriores (lateral esquerda e inferior). 
Pode fazer clique nas setas a meio da barra inferior para inverter a gradação das barras e 
todo o sentido da linha. Quando estas barras vão da tonalidade escura, nas pontas, para a 
clara, no canto inferior esquerdo onde confluem, os valores de Input e Output são expres-
sos em percentagem. Se inverter a gradação das barras, estes valores são expressos em 
níveis de cor.
Quando um ponto na curva está seleccionado (ele apresenta-se a preto, cheio), os valores 
de Input e Output, na parte inferior esquerda da janela, reflectem os valores desse ponto 
antes e depois da alteração na curva.

•  Color Balance  / Equilíbrio de Cores
Ajuste de cores ao alterar a sua posição na roda de cores RGB/CMY, mostrando a relação 
entre as cores aditivas, à direita, e as cores subtractivas, à esquerda. Ao arrastar um dos 
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deslizadores, subtraímos uma das cores, acrescentando a sua complementar. Também é 
possível digitar valores numéricos, entre -100 e +100, nos três campos à frente de Color 
Levels. Os ajustes devem ser pequenos; alterações superiores a 3-5 unidades acima ou 
abaixo de 0 provocam alterações bruscas.
Esta ferramenta não oferece a precisão dos níveis (Levels) ou curvas (Curves). Os ajustes de 
cor têm de ser feitos separadamente nos tons escuros (Shadows), meios-tons (Midtones) e 
nos tons claros (Highlights). 
A opção Preserve Luminosity deve estar activa, para preservar a luminosidade da imagem. 

•  Brightness/Contrast / Brilho/Contraste
Este comando é provavelmente a ferramenta mais intuitiva, mas não muito útil, porque os 
seus efeitos são aplicados a todos os canais simultaneamente, e não oferece precisão. Se 
exagerar nas alterações de cor, pode mesmo danificar a integridade da sua imagem, preju-
dicando o detalhe. Utilizar uma curva em forma de “S” na janela das Curvas (Curves), é uma 
forma muito mais precisa de conferir contraste a uma imagem.

• Hue/Saturation... / Matiz/saturação
Edita cores com base no modelo de cor HSB. Podemos também colorir imagens a preto e 
branco que foram convertidas para RGB ou CMYK ou adicionar cor a uma imagem RGB, 
para, por exemplo, fazê-la parecer como um Duotone, ao reduzir os seus valores de cor a 
uma única tonalidade.
Para colorir uma imagem, deve estar activa a opção Colorize. Neste caso, o Photoshop apli-
ca automaticamente o nível máximo de saturação e o deslizador é alterado para ler apenas 
de 0 a 100, o que significa que só se pode reduzir a saturação.

• Desaturate / Remover Saturação
Reduz a saturação de todas as cores a 0, criando o efeito de uma imagem em escala de 
cinzentos, sem, no entanto, alterar o modo de cor. É o mesmo que mover o deslizador de 
saturação totalmente para a esquerda, no diálogo Hue/Saturation. 

• Match Color / Corresponder Cor
Este comando cria uma correspondência de cores entre várias imagens, entre várias cama-
das ou entre várias selecções coloridas. Também permite ajustar a cor numa imagem ao 
mudar a luminosidade, a gama de cor e neutralizar uma cor predominante. Este comando 
funciona apenas em modo RGB.

• Replace Color / Substituir cor
Utilizar este comando é semelhante a fazer uma selecção através do comando Select > Co-
lor Range, mas aqui pode substituir de imediato as cores através de controlos iguais aos 
da caixa de diálogo Hue/Saturation. As cores são seleccionadas ao fazer clique na imagem 
com as pipetas, evitando a necessidade de selecções complexas.
O deslizador de Fuziness determina a amplitude da gama de cores a trabalhar. 

• Selective Color / Cor Seletiva
Este comando é usado principalmente para “afinar” cores para impressão em quadricomia 
e, embora esteja disponível também em RGB, é mais eficaz no modo CMYK.
Na lista à frente de Colors pode escolher a cor que pretende alterar selectivamente. As op-
ções são: vermelho, amarelo, verde, cião, azul, magenta, branco, tons neutros e preto.

• Channel Mixer / Misturador de Canais
Este “misturador de canais” permite copiar informação de um canal e colocá-la noutro, 
sendo muito útil para melhorar algumas cores, especialmente ao trabalhar com separações 
(CMYK), e também para criar uma imagem em cinzentos a partir de uma imagem a cores, 
realçando algumas tonalidades. 

•  Gradient Map / Mapa de Degradê
Este comando permite cobrir toda a imagem com uma gradação de cor, criando efeitos 
interessantes, como, por exemplo, um efeito semelhante ao de um Duotone. Se fizer clique  
na seta do lado direito da barra de cor, pode editar os degradés disponíveis – ou criar ou-



69ADOBE PHOTOSHOP CS

Formadoras: ÂNGELA RODRIGUES e ISABEL PINTO

tros – para escolher o que pretende. Se utilizar um com várias cores, a imagem pode ficar 
com um efeito “posterizado”, com transições bruscas entre cores.

• Photo Filter / Filtro de Fotos
Esto comando pretende simular a técnica de colocar um filtro colorido sobre a lente da câ-
mara fotográfica para ajustar o balanço e a temperatura de cor. Também permite escolher 
uma cor para aplicar um ajuste de tonalidade à imagem. 

• Invert / Inverter
Altera cada pixel para o seu valor inverso, criando um efeito semelhante ao de um negati-
vo. Pode ser especialmente útil para usar em máscaras, invertendo a sua função, ou para 
qualquer efeito especial. Pode também seleccionar uma área e inverter apenas a selecção.

• Equalize / Equalizar
Redestribui a gama tonal de uma imagem ao intensificar os valores do ponto mais claro e 
mais escuro de uma imagem, fazendo com que passem respectivamente a branco e preto 
puros, e expandindo a restante gama tonal. É um comando de aplicação directa, sem qual-
quer janela de diálogo.

• Threshold / Limiar
Este comando coloca a imagem no “limite” dos tons, passando a preto todos os tons es-
curos e a branco os tons claros. Pode ser uma forma de simular uma imagem em modo 
bitmap, sem alterar o modo de cor. 

• Posterize / Posterizar
Reduz os níveis de cor da imagem, criando um efeito semelhante ao das imagens em banda 
desenhada. Com um valor 4 numa imagem RGB, a imagem ficará reduzida a 12 níveis de 
cor, 4 em cada canal. 

• Variations / Variações
As “variações” permitem alterar de uma forma rápida e intuitiva, mas não muito precisa, as 
cores de uma imagem. Na mesma janela, pode aplicar simultaneamente os comandos de 
balanço de cor (Color Balance), alterar o contraste e a saturação da imagem. 

Duplicate / Duplicar
Abre uma janela para dar o nome a uma duplicação da imagem no estado actual. Esta imagem 
está apenas aberta no ecrã; se pretender guardá-la, terá de a salvar para o disco (menu File > 
Save As). Na janela de duplicação pode assinalar a opção Duplicate Merged Layers Only, o que 
cria uma cópia com todas as camadas coladas numa única imagem de fundo (Background).

Apply Image / Aplicar imagem
Através deste comando podem combinar-se imagens, camadas e canais. Para isso, elas têm de 
ter exactamente a mesma resolução e o mesmo tamanho.
A função básica deste comando é copiar uma imagem, camada ou canal (Source), e com ela 
substituir outra imagem, camada ou canal (Target). Esta última é sempre a imagem activa. A 
outra imagem (Source) pode ser seleccionada entre as imagens abertas. 
Este comando também pode utilizar apenas uma imagem, misturando camadas e ou canais com 
diferentes modos de mistura de cor e ou opacidades para conseguir efeitos interessantes.

Calculations / Cálculos
O comando Calculations é semelhante ao comando Apply Image, na medida em que pode 
misturar dois canais de duas imagens ou da mesma imagem, mas neste caso o resultado é um 
novo canal, uma selecção ou um novo documento cinzento (em modo Multichannel).
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Image Size / Tamanho da imagem
Janela para modificar o tamanho e a resolução.
Na primeira secção desta janela (Pixel Dimensions – di-
mensões em pixéis) surge informação sobre a dimensão 
da imagem em pixéis. Na secção Document Size, tem 
um campo para definir a largura e altura, e a resolução 
(quantidade de pixéis por polegada ou por centímetro 
que formam a imagem). As correntes do lado direito 
significam que os campos estão ligados, mantendo au-
tomaticamente as proporções: sempre que alterar uma 
das medidas, a outra muda proporcionalmente. Para 
distorcer a imagem, desactive Constrain Proportions.
A opção Scale Styles permite que, ao mudar o tama-
nho de uma imagem, os estilos que lhe tenham sido 
aplicados sejam também redimensionados.
A última caixa é Resample Image (refazer a imagem) e está geralmente activa. Se a desactivar, 
o número de pixéis na imagem será mantido (a primeira parte da janela fica indisponível), ou 
seja, ao alterar a largura, a altura ou a resolução, a quantidade de pixéis mantém-se. 
Quando a opção está activa, o programa pode usar um dos seguintes métodos ao refazer a 
imagem (chamam-se métodos de interpolação):

•  Bicubic é o que está predefinido e o que apresenta melhor qualidade, embora mais lento. O 
programa faz a média de todos os pixéis em cada zona da imagem para recriar pixéis;

•  Bicubic Smoother será a melhor opção quando precisa de ampliar uma imagem;

•  Bicubic Sharper é indicado para reduções; em alguns casos pode exagerar o efeito Sharpen 
(focalização). Se isso acontecer, tente o método Bicubic; 

•  Bilinear procura os pixéis adjacentes apenas na horizontal e na vertical para reproduzir a 
imagem, sendo portanto mais rápido mas menos perfeito;

•  Nearest Neighbour não efectua qualquer tipo de cálculo ao refazer a imagem, limitando-se 
a repetir a cor do pixel mais próximo. É o método mais rápido, mas resulta frequentemente 
em imagens de má qualidade.

Na janela de preferências, no painel General, também se determina um método de interpo-
lação das imagens. Essa definição é aplicada em comandos que refazem a imagem, mas não 
oferecem escolha para interpolação (como o comando Transform, por exemplo). 

Canvas Size... / Tamanho da Tela de Pintura
Janela onde se pode aumentar ou diminuir a área de trabalho; a imagem mantém o tamanho. 
Se especificar uma área de trabalho menor do que a imagem, ela pode ficar cortada. Neste 
caso, o programa emite um aviso. 

Pixel Aspect Ratio / Proporções de Pixel
Uma imagem visualizada no monitor de um computador é composta por pixéis essencialmente 
quadrados. Ao passar imagens para video, usam-se pixéis não quadrados para evitar distorção 
da imagem; neste caso, deve escolher o tipo de pixel através deste submenu.

Rotate Canvas / Girar Tela de Pintura
Lista um submenu no qual pode escolher como quer rodar a área de trabalho (com todas as 
camadas incluídas) ou ainda inverter a imagem horizontal ou verticalmente (Flip).
CW é abreviatura de Clockwise (significa: no sentido dos ponteiros do relógio) e CCW é o in-
verso, Counter Clockwise (no sentido inverso ao dos ponteiros do relógio).



71ADOBE PHOTOSHOP CS

Formadoras: ÂNGELA RODRIGUES e ISABEL PINTO

Crop / Corte
Corta a área de trabalho com o tamanho da selecção activa. Só está disponível quando existe 
uma área seleccionada.

Trim... / Aparar
Janela onde especifica critérios de cor para cortar a imagem. Pode basear o corte em (Based 
on): Transparent Pixels (pixéis transparentes); Top Left Pixel Color (cor do pixel no canto supe-
rior esquerdo); Bottom Right Pixel Color (cor do pixel no canto inferior direito).
Na secção inferior (Trim Away – cortar a parte), pode escolher cortar: Top (a parte de cima); 
Bottom (a parte de baixo); Left (o lado esquerdo); Right (o lado direito).

Reveal All / Revelar Tudo
O comando Reveal All / Revelar Tudo aumenta, de forma automática, a área de trabalho, por 
forma a caberem todas as camadas, mesmo que não estejam visíveis, total ou parcialmente. 

Trap / Acerto de Cor
Permite um acerto de cor para imagens em quadricomia destinadas a impressão. Só está dis-
ponível em modo CMYK e recomenda-se o uso apenas para cores sólidas; não produz bons 
resultados em imagens de tons contínuos (imagem fotográfica). Este acerto estabelece uma 
pequeníssima área em que as cores se sobrepõem para evitar falhas ao imprimir. 

Menu Layer / Camada

New / Nova

Cria uma nova Camada / Layer ou Conjunto de Camadas  / Layer 
Set, através das opções:
•  Layer/Camada: Nova camada de imagem, acima da camada activa.
•  Background From Layer / Plano de Fundo a Partir da Cama-

da: Transforma a Camada / Layer activa em Imagem de Fundo 
/ Background. Quando já existe imagem de fundo, este menu 
apresenta a opção inversa: Layer from Background / Camada a 
Partir do Plano de Fundo;

•  Layer Set / Conjunto de Camadas: Cria uma pasta (ou conjunto) 
de camadas.

•  Layer Set from Linked / Conjunto de camadas a partir de vincu-
ladas: Cria uma pasta (ou conjunto) de camadas com todas as 
camadas ligadas entre si;

•  Layer via Copy: Cria uma nova camada com a área seleccionada 
(é o mesmo que fazer Copy e Paste);

•  Layer via Cut: Cria uma nova camada cortando a área seleccionada 
da camada activa (é o mesmo que fazer Cut e Paste). 

Duplicate Layer / Duplicar a Camada

Cria uma cópia (duplicação) da camada activa. Pode gravar a du-
plicação num dos ficheiros abertos ou criar um ficheiro novo. 

Delete / Apagar

Permite apagar: a camada activa;  as camadas que lhe estão liga-
das ou as camadas escondidas.
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Layer Properties... / Propriedades da Camada...

Janela para dar nome à camada (ou alterar o nome dado) e ainda atribuir uma cor para figurar 
na Paleta de Camadas.

Layer Style / Estilos de Camadas

Abre um  submenu com opções para trabalhar com estilos de camadas. 
•  Blending Options (opções para modos de mistura de cores) – Dá acesso a uma janela com 

especificações para mistura de cores. 
•  Copy Layer Style – Copia o estilo aplicado à camada activa (só está disponível quando a 

camada tem um estilo). Esta cópia do estilo fica em memória e pode depois ser aplicada 
através dos dois comandos seguintes;

•  Paste Layer Style – Aplica o último estilo copiado à camada activa;
•  Paste Layer Style to Linked – Aplica o último estilo copiado a todas as camadas ligadas (uma 

das camadas da cadeia de ligação tem de estar activa);
•  Clear Layer Style – Retira o estilo aplicado à camada activa;
•  Global Light (luz global) – Abre uma janela para estabelecer o ângulo e a altura da luz global 

usada em alguns efeitos de camadas;
•  Create Layer – Cria uma nova camada com os efeitos aplicados à camada activa, ficando 

estes isolados e transformados em pixéis. Deixam de poder ser editados como efeitos, mas 
permitem outras manipulações;

•  Hide All Effects – Esconde (não apaga) todos os efeitos. Pode depois voltar a este menu, que 
apresentará a opção: Show All Effects. Com um clique sobre o “olho” ao lado da barra de 
efeitos, na Paleta de Camadas, consegue o mesmo resultado;

•  Scale Effects – Abre uma janela onde pode fornecer um valor (em percentagem) para aumen-
tar ou diminuir o(s) efeito(s) aplicado(s) à camada activa.

New Fill Layer / Nova Camada de Preenchimento

Cria uma nova camada que pode ser preenchida: com uma cor sólida (Solid Color), com uma 
gradação de cor (Gradient) ou com um padrão (Pattern). 

New Adjustment Layer / Nova camada de Ajustamento

Cria uma nova camada de ajustamento (os mesmos ajustes que pode fazer através do menu 
Image > Adjustments); o ajuste desta camada irá afectar todas as camadas inferiores.

Change Layer Content / Mudar o Conteúdo da Camada

Altera o conteúdo de uma camada de preenchimento ou de ajustamento, escolhendo de uma 
listagem se o novo conteúdo vai ser uma cor sólida, um degradé, um padrão ou um ajusta-
mento de cor. Esta opção não está disponível para camadas de imagem ou de texto.

 Layer Content Options / Opções de Conteúdo da Camada

Reedita a janela da camada de preenchimento ou de ajustamento, podendo fazer alterações. 

Type / Texto

Submenu com opções para trabalhar camadas de texto:
•  Create Work Path – Cria um path temporário com o texto da camada activa. O texto man-

tém-se inalterado;
•  Convert to Shape – Converte a camada de texto numa camada de formas vectoriais;
•  Horizontal – Modifica a orientação de texto vertical para horizontal;
•  Vertical – Modifica a orientação de texto horizontal para vertical;
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•  Anti-Alias ... – os cinco comandos seguintes aplicam ao texto diferentes métodos de Anti-
aliasing (suavização dos contornos das letras);

•  Convert to Paragraph Text – Ao usar a ferramenta de texto pode simplesmente fazer um 
clique na área da imagem e começar a escrever, sem qualquer limitação de medida. 
Se traçar uma caixa com a ferramenta antes de começar a escrever, estará a limitar a área 
para escrita e o texto passará para a linha de baixo sempre que atinja a margem direita, em 
parágrafos. Este tipo de texto é Paragraph Text. Neste sub-menu pode converter texto de 
um para outro tipo. 
Ao converter de Paragraph para Point Text, os fins de linha passam a ser fixos.

•  Warp Text – Janela onde pode distorcer texto aplicando formatos predefinidos.
•  Update All Text Layers – Actualiza todas as camadas de texto. É um comando que pode ser 

útil quando se abre um ficheiro de imagem que foi criado noutra versão do programa e ne-
cessita actualizar as camadas de texto.

•  Replace All Missing Fonts – Substitui todas as fontes em falta de uma vez só.

Rasterize / Rasterizar

Mostra um submenu com opções para rasterizar camadas, o que significa transformar vectores em 
pixéis (texto, formas vectoriais, camadas com um preenchimento de cor, máscaras vectoriais).

New Layer Based Slice / Nova Fatia com Base em Camadas

Transforma o conteúdo de uma camada numa fatia (slice) para ser usada num trabalho desti-
nado à Internet.

Add Layer Mask / Adicionar Máscara à Camada

Submenu com opções para criar/apagar uma máscara na camada activa. Pode escolher:
•  Reveal All – Cria uma máscara vazia (branca);
•  Hide All – Cria uma máscara opaca (preta).
Se tiver uma selecção activa, as duas opções seguintes estarão disponíveis:
•  Reveal Selection – Cria uma máscara que revela apenas o conteúdo da selecção (área preta 

da máscara);
•  Hide Selection – Cria uma máscara que esconde o conteúdo da selecção (área preta da máscara). 

Enable/Disable Layer Mask / Activa/Desactiva a Máscara da Camada

Activa/desactiva a máscara da camada seleccionada, permitindo ver como fica sem a máscara. Quan-
do a máscara está inactiva, pode ver-se um “X” vermelho sobre a máscara, na Paleta de Camadas. 
Pode obter o mesmo resultado fazendo clique sobre a miniatura da máscara, ao mesmo tempo que 
pressiona a tecla Shift.

Add Vector Mask / Adicionar Máscara Vectorial

Mostra um submenu com opções para criar/apagar uma máscara vectorial na camada activa. 
Pode escolher:
•  Reveal All – Cria uma máscara vazia (branca);
•  Hide All – Cria uma máscara opaca (cinzenta);
•  Current Path – Com um Path activo, na Paleta de Paths, transforma-o na máscara da camada 

seleccionada.

Delete Vector Mask / Apagar Máscara Vectorial

Apaga a máscara vectorial da camada seleccionada.
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Enable/Disable Vector Mask / Activa/Desactiva a Máscara Vectorial

Activa/desactiva a máscara vectorial da camada seleccionada, permitindo ver como fica a 
camada sem a máscara.

Create Clipping Mask / Criar Máscara de Corte

Agrupa a camada activa com a anterior ou com as camadas que lhe estão agrupadas (se for o 
caso), criando um grupo de recorte. Na prática, quer dizer que a camada de baixo serve de más-
cara à camada activa, sendo visível apenas a parte em que as duas camadas se interceptam.

Release Clipping Mask / Soltra Máscara de Corte

Desagrupa a(s) camada(s), desfazendo o efeito de máscara recortante.

Arrange / Organizar

Submenu onde se pode alterar a ordem das camadas na Paleta de Camadas. Esta opção não 
está disponível quando está activo o Background (imagem de fundo), quando não existem 
camadas ou quando existe apenas uma camada. As escolhas são:
•  Bring to Front – Passar para a frente de tudo a camada activa;
•  Bring Forward – Passar a camada activa uma posição para a frente;
•  Send Backward – Passar a camada activa uma posição para trás;
•  Send to Back – Passar para trás de tudo a camada activa.

Align Linked / Alinhar Vinculadas

Submenu para escolher um alinhamento para as camadas ligadas (desde que uma das 
camadas da ligação esteja activa). O alinhamento pode ser vertical ou horizontal, e pode 
ser efectuado também através da Barra de Opções, quando a Ferramenta de Mover ( ) se 
encontra seleccionada e está activa uma camada com outra(s) camada(s) ligada(s).

Distribute Linked / Distribuir Vinculadas

Submenu onde pode escolher uma distribuição para três ou mais camadas ligadas (desde que 
uma das camadas da ligação esteja activa). A distribuição pode ser baseada nos seus topos, 
bases, lados esquerdos, direitos ou ainda centros. Esta distribuição pode também podem ser 
efectuada através da Barra de Opções. 

Lock All Linked Layers / Bloquear Todas as Camadas no Conjunto

Janela para bloquear todas as camadas ligadas à que está activa, podendo escolher bloquear: 
•  Transparency (a transparência) – não pode “pintar” nas zonas transparentes;
•  Image (a imagem) – não pode alterar os pixéis da imagem (acrescentar ou apagar);
•  Position (a posição) – não pode mover a  camada;
•  All (tudo) – todas as camadas ligadas ficam completamente bloqueadas.
Pode obter o mesmo efeito através dos ícones na parte superior da Paleta Camadas (ver ima-
gem da página 48, ponto 2).

Merge Down / Mesclar para Baixo

Cola a camada activa à de baixo, fundindo-as numa só camada. Se a camada activa estiver 
ligada a outra(s), este comando será Merge Linked / Mesclar Vinculadas e resultará numa só 
camada com o conteúdo de todas as camadas que estiverem ligadas. Se a camada activa es-
tiver agrupada com outra(s) que lhe seja(m) superior(es), este comando será Merge Clipping 
Mask / Mesclar Máscara de Corte e resultará numa só camada com o conteúdo de todas as que 
pertencerem ao grupo “mascarado”.
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Merge Visible / Colar Visíveis

Cola todas as camadas visíveis, fundindo-as numa só camada. O nome da camada resultante 
será o da activa no momento da fusão.

Flatten Image / Achatar Imagem

Cola todas as camadas, numa única camada de fundo, o Background / Imagem de Fundo. Se 
existirem camadas invisíveis, surge uma mensagem de alerta. 

Matting / Resíduos

Quando se corta ou se move uma selecção (com a opção Anti-aliased activa), os contornos con-
servam, muitas vezes, restos de cor do fundo original, resultando numa orla de cor indesejável. 
Este menu oferece opções para eliminar essas matizes nos contornos da camada. Os pixéis nos 
limites da camada são “esticados” para cobrir a “franja” de cor indesejada. Pode escolher:
• Defringe –  Janela para definir um valor em pixéis. Esta é a área definida como a orla com 

cor(es) a remover;
• Remove Black Matte – Remove orla de cor preta;
• Remove White Matte – Remove orla de cor branca.

Menu Select / Selecção

All / Tudo

Selecciona toda a área da imagem. 

Deselect / Desseleccionar

Desselecciona todas as áreas seleccionadas. 

Reselect / Resseleccionar

Restaura a última selecção feita.

Inverse / Inverso

Inverte a selecção, ou seja, a área que está seleccionada deixa de 
estar e a área fora da seleccção passará a estar seleccionada.

Color Range / Gama de Cor

Janela onde podem ser feitas selecções baseadas numa determinada gama de cor. Podem ser 
feitas na camada activa ou numa área seleccionada. 
À frente do campo Select, pode escolher o tipo de selecção que pretende fazer. 
A pipeta simples retira uma amostra de cor; a pipeta (+) adiciona cores; a pipeta (–) retira cores.
O deslizador de Fuziness aumenta ou diminui a gama de cor, com base na primeira selecção. 
Na zona central da janela, pode ver a imagem com as zonas seleccionadas a branco e as não 
seleccionadas a preto. Na parte inferior da janela, em Selection Preview, pode escolher outra 
forma de pré-visualizar a selecção sobre a imagem.

Feather / Difusão

Janela onde pode dar um valor (em pixéis) para gradualmente esbater os contornos de uma 
selecção até à transparência, em vez de estes contornos serem rígidos. Esta opção também 
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está presente na Barra de Opções de todas as ferramentas de selecção, mas para a activar tem 
de ser fornecido um valor antes de usar a ferramenta. 

Modify / Modificar

Modificar a selecção existente para uma orla com determinados pixéis (Border), suavizar a 
selecção (Smooth), expandi-la (Expand) ou contraí-la (Contract).

Grow / Aumentar

Aumenta a selecção para incluir mais pixéis de cor semelhante. A quantidade de pixéis é deter-
minada pelo valor no campo da tolerância na Barra de Opções da Ferramenta Varinha Mágica.

Similar / Semelhante

Alarga a selecção a todas as áreas com cores semelhantes às incluídas na área seleccionada.

Transform Selection / Transformar a Selecção

Este comando permite transformar a selecção. Para isso surge uma caixa limitadora da selec-
ção, com oito pegas, que permite rodar, aumentar e diminuir a área seleccionada (apenas os 
limites da área são afectados, o seu conteúdo permanece inalterado). Para distorcer a área, 
puxe uma das pegas premindo ao mesmo tempo a tecla z/Ctrl.

Load Selection / Ler Selecção

Janela onde se pode carregar uma selecção guardada num canal alfa. Pode conseguir o mes-
mo efeito se fizer clique sobre a miniatura do canal alfa, premindo ao mesmo tempo a tecla 
z/Ctrl.

Save Selection / Guardar Selecção

Abre uma janela onde se pode guardar a selecção activa num canal alfa para utilização posterior. 

Menu Filter / Filtros

Os filtros são efeitos especiais aplicados aos pixéis de uma ima-
gem, por forma a obter determinadas alterações. Alguns deles 
só funcionam no modo RGB.

Last Filter / Último Filtro

Reaplica o último filtro usado, com os mesmos valores. Se 
pressionar a tecla [Alt] ao mesmo tempo que escolhe este 
submenu, abre-se a janela de diálogo correspondente ao úl-
timo filtro usado e pode alterar os valores para aplicação.

Extract / Extrair

O comando Extract permite isolar áreas de uma imagem de for-
ma simples e é especialmente útil quando a área que pretende 
isolar tem contornos difíceis, como por exemplo, pêlos ou ca-
belos. Aconselha-se que trabalhe numa cópia do original ou que 
duplique a camada em que vai trabalhar, pois este comando vai 
efectivamente apagar as áreas exteriores ao contorno.
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Use o marcador do contorno para definir o objecto a isolar, arrastando com o rato.  Deve dese-
nhar uma forma fechada; no caso de a imagem ir até ao limite, não  necessita de contornar os 
extremos do ecrã. Depois de desenhar o contorno, deve fazer clique dentro da área a isolar, com 
a ferramenta de preenchimento. 
Faça clique sobre o botão [Preview] para ver como o comando será aplicado à sua imagem. 

Filter Gallery / Galeria de Filtros

A Galeria de Filtros permite aplicar filtros cumulativamente e também aplicar filtros indivi-
duais mais do que uma vez. Pode também mudar os valores de filtros já aplicados.
Nem todos os filtros podem ser aplicados através da galeria.

Liquify / Dissolver

Este comando permite fazer distorções na imagem, como se se tratasse de uma imagem líqui-
da. As ferramentas do comando Liquify são: 
• Warp – “arrepanha” a imagem, à medida que arrasta o rato; 
•  Turbulence – produz um efeito semelhante, mas com esta ferramenta deve deixar o cursor 

parado e premir continuamente o rato para ver a área a ficar “torcida”; 
• Twirl Clockwise – produz um remoinho no sentido dos ponteiros do relógio; 
•  Twirl Counterclockwise – produz um remoinho no sentido inverso ao dos ponteiros do relógio;
•  Pucker – “enruga” a área, produzindo um efeito de “engelhar”. Funciona por pressão contí-

nua do rato, sem arrastar;
• Bloat  – “incha” a zona onde pressiona continuamente o rato;
•  Shift Pixels – movimenta os pixéis em ângulos de 90 graus, acompanhando o movimento do 

cursor, e no sentido da direita para a esquerda;
•  Reflection – copia os pixéis do lado direito do brush/pincel e repete-os, reflectidos como 

num espelho, nas áreas sobre as quais o cursor vai passando;
•  Reconstruction – reconstrói os pixéis sobre os quais passa com esta ferramenta, repondo 

selectivamente a imagem original. 
•  Freeze – passando com esta ferramenta sobre áreas da imagem, protege essas áreas de se-

rem distorcidas acidentalmente por qualquer das outras ferramentas. As áreas protegidas 
são cobertas por uma cor. 

•  Thaw – esta ferramenta permite desproteger as áreas antes protegidas com a ferramenta 
Freeze. 

Pattern Maker / Criador de Padrões
Permite construir padrões complexos, de uma forma fácil, a partir de uma área seleccionada, 
obtendo padrões muito mais sofisticados do que através do menu Edit > Define Pattern.

Artistic / Artístico

Os filtros deste grupo tentam reproduzir as técnicas artísticas. Definem áreas de cor seme-
lhante e utilizam uma cor intermédia ou misturam a cor para apresentar áreas de cor sólida.

Blur / Desfoque

Os filtros de desfocagem suavizam a imagem e podem ser muito úteis para retoque. Os filtros 
Blur e o Blur More são por vezes utilizados para diminuir o efeito de moiré, quando se digita-
liza imagens já impressas. Também são úteis para eliminar ou diminuir grão e poeiras.

Brush Strokes / Traçados de Pincel

Semelhantes aos artísticos, simulam o uso de diferentes tipos de pincéis e tintas.
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Distort / Distorção

À excepção do filtro Diffuse Glow, estes filtros distorcem a imagem, sem alterar os valores de 
cor. Alguns podem usar outras imagens como padrão para certas distorções.

Noise / Ruído

Este grupo de filtros adiciona ou remove “ruídos”, tais como poeiras e riscos, de uma imagem.

Pixelate / Pixelização

Os filtros Pixelate subdividem a imagem em pequenas áreas de cor, como células. Destroem o 
detalhe e substituem-no por cores alteradas.

Render / Acabamento

Os filtros Render interpretam a informação de cor da imagem e com base nela adicionam in-
formação, criando efeitos tridimensionais, reflexões de luz e texturas. Também podem criar 
uma imagem inteiramente diferente, como no caso dos filtros Clouds.

 Sharpen / Nitidez

Os filtros Sharpen “aguçam” os contrastes da imagem, tornando-a mais focada. São o inverso 
dos filtros Blur. Usam-se muitas vezes para melhorar imagens de máquinas digitais ou ima-
gens provenientes de scanners com pouca resolução.

 Sketch / Croqui

Os filtros Sketch tentam reproduzir técnicas de desenho, usando as cores Foreground e Back-
ground para aplicar traços grosseiros à imagem, com um aspecto de esboço. Os efeitos são 
mais realistas quando as cores usadas são o preto e o branco.

 Stylize / Estilização

Os filtros Stylize produzem imagens com aspecto de pinturas impressionistas, estilizadas. 
Deslocam pixéis e exageram os contrastes da imagem. Depois de utilizar filtros como Find 
Edges ou Trace Contour, pode aplicar o comando Image > Adjustments > Invert para realçar 
os contornos de uma imagem a cores com linhas coloridas ou para contornar a branco uma 
imagem em tons de cinzento.

 Texture / Textura

Estes filtros conferem à imagem um aspecto texturado. 

Video 

Estes filtros são exclusivos para imagens capturadas de video ou destinadas a ser utilizadas 
em vídeo.

 Other / Outros

É um conjunto de filtros que não se encaixam facilmente numa categoria.

 Digimarc 

Os filtros Digimarc são fornecidos com o Photoshop mas pertencem à Digimarc Corporation e 
não podem sem usados sem um pagamento àquela empresa. Servem para colocar na imagem 
uma marca digital, protegendo os direitos de autor.
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Menu View / Visualização

Proof Setup / Configurações de Prova

Mostra um submenu onde podem simular-se diferentes pa-
râmetros para visualização da imagem em várias condições 
de cores.

Proof Colors / Cores de Prova

Activa/desactiva a pré-visualização da imagem com os pa-
râmetros definidos no submenu anterior (Proof Setup).

Pixel Aspect Ratio Correction / Correção de 
Proporções de Pixel

Numa imagem à qual foi aplicada uma correcção das 
proporções de pixel (Pixel Aspect Ratio), através do menu 

Image, pode aqui, desligar esse efeito.

Gamut Warning / Aviso de Gamut

Activa/desactiva um avisador de cor fora de gama, 
que vai destacar a(s) cor(es) que não serão impressas 
correctamente em quadricomia (CMYK). 

Zoom In / Aumentar o Zoom

Amplia a visualização da imagem do ficheiro activo.

Zoom Out / Diminuir o Zoom

Reduz a visualização da imagem do ficheiro activo.

Fit On Screen / Ajustar à Tela

Ajusta a visualização da imagem por forma a que esta encha o écrã.

Actual Pixels / Tamanho Original

Mostra a imagem a 100 % (de acordo com a resolução do ecrã).

Print Size / Tamanho de Impressão

Mostra a imagem no tamanho em que será impressa.

Extras / Extras

Mostra/esconde a visualização dos elementos listados no submenu seguinte (Show).

Show / Mostrar

Desenrola uma lista na qual se podem seleccionar os elementos da imagem que serão mos-
trados/escondidos com o submenu anterior (Extras) activo ou desactivo. Os elementos des-
ta lista são: Selection Edges (contornos da selecção); Target Path (Demarcador activo); Grid 
(grelha); Guides (guias); Slices (fatias) e Annotations (anotações). Pode escolher All (todas) ou 
None (nenhuma), em vez de seleccionar cada opção individualmente. Finalmente, pode clicar 
sobre Show Extras Options... que lhe mostra outra janela onde pode assinalar as opções que 
pretende que apareçam nesta janela.
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Rulers / Réguas

Mostra/esconde as réguas (horizontal e vertical) no lado esquerdo e no topo da janela. 
Destas réguas podem puxar-se guias, bastando clicar sobre uma das réguas e arrastar, com 
qualquer ferramenta. Para retirar as guias individualmente, arraste-as de novo para a régua 
de origem, com a Ferramenta Mover ( ), ou carregue na tecla z/[Ctrl] (que permite o acesso 
temporário à Ferramenta de Mover).

Snap / Ajustar

Activa/desactiva a atracção automática dos pixéis, selecções, etc., a alguns elementos, lista-
dos a seguir.

Snap To / Ajustar A

Desenrola uma lista na qual se pode seleccionar quais os elementos que vão servir de “iman” 
aos pixéis, selecções, etc.

Lock Guides / Bloquear Guias

Bloqueia/desbloqueia todas as guias, impedindo deslocações acidentais.

Clear Guides / Apagar Guias

Retira todas as guias.

New Guide / Nova Guia

Abre uma janela na qual se pode posicionar uma guia horiontal ou uma vertical, com um valor 
numérico. 

Lock Slices / Bloquear Fatias

Bloqueia/desbloqueia todas as fatias, impedindo deslocações acidentais.

Clear Slices / Apagar Fatias

Retira todas as fatias.

Menu Window / Janela

Arranje / Organizar

Opções para visualizar os documentos de Photoshop abertos.

Workspace / Espaço de Trabalho

Submenu onde pode salvar a configuração em uso da área de tra-
balho, com as respectivas paletas abertas num determinado local 
e num modo de cor; escolha Save Workspace... e atribua um nome. 
Pode também ir buscar outra configuração, previamente guardada, 
fazendo clique sobre o seu nome que aparece listado na parte in-
ferior da janela. Para regressar à configuração inicial das Paletas, 
escolha Reset Palette Locations.

Paletas 
O resto do menu tem uma lista das paletas usadas pelo programa, 
que pode mostrar ou esconder.
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Menu Help / Ajuda

Photoshop Help... / Ajuda do 
Photoshop

Mostra um manual de ajuda do Photoshop, 
em formato de página da Web. Não é neces-
sário ligação à Internet para ler e usar este 
manual.

Welcome Screen / Tela 
Bem-Vindo

Mostra uma janela de Boas-Vindas, onde 
pode consultar alguns tutoriais, ver quais as 
novas opções desta versão do Photoshop, e 
outras utilidades.

Export Transparent Image... / 
Exportar Imagem Transparente

Janela de diálogo que ajuda o operador a 
exportar uma imagem com transparências.

Resize Image / Redimensionar imagem

Janela de diálogo que ajuda o operador a redimensionar uma imagem com o mínimo de perda 
de qualidade.

System Info... / Informações sobre o Sistema

Mostra informações sobre o computador, o sistema operativo, a versão de Photoshop e exten-
sões (plug-ins) instaladas.

Updates... / Atualizações

Procura actualizações para a sua versão de Photoshop. Necessita de uma ligação à Internet.

Registration... / Registro

Estabelece uma ligação ao site da Adobe para poder registar-se. Requer uma ligação à Internet.

Photoshop Online... / Photoshop On-line

Estabelece uma ligação ao site da Adobe. Requer uma ligação à Internet.

How To... / Como...

Os tópicos seguintes, levam à janela de Ajuda do Photoshop, onde pode procurar como exe-
cutar determinadas tarefas.


